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1.1 The Tolomatic ACS Drive/Controller
It is important to know which model Tolomatic ACS Drive/Controller you are 
programming. The stepper and servo units are the same size, color and externally 
are only different on the left panel. Use the part number on the label to confirm the 
Tolomatic ACS Drive/Controller you are programming. 

Figure 1-1: Use the part number to identify the Tolomatic ACS Drive Controller you are 
programming

ACS Stepper Drive
Currently there are three ACS Stepper Drive/Controller choices: 
	 • #3604-9651 (ACST0324SD) - ACS Stepper Drive/Controller, Basic  
	    firmware 36043144SD.hex
	 • #3604-9654 (ACST0324ED) - ACS Stepper Drive/Controller, EtherNet/IP  
	    firmware 36043175ED.hex
	 • #3604-9655 (ACST0324MD) - ACS Stepper Drive/Controller, Modbus TCP 
	    firmware 36043176MD.hex

ACS Servo Drive
Currently there are three ACS Servo Drive/Controller choices: 
	 • #3604-9661 (ACSV2048UD) - ACS Servo Drive/Controller, Basic 
	    firmware 36043177.tol
	 • #3604-9662 (ACSV2048ED)- ACS Servo Drive/Controller, EtherNet/IP  
	    firmware 36043177.tol
	 • #3604-9663 (ACSV2048MD)- ACS Servo Drive/Controller, Modbus TCP  
	    firmware 36043177.tol

 NOTE: They will collectively be referred to as ACS Drive throughout this guide

 NOTE:  

It is important to 

identify the motor and 

corresponding ACS 

drive system (Stepper 

or Servo) being used! 

Because the TMI 

software allows an 

offline connection 

that does not require 

the Tolomatic 

drive. This offline 

connection allows 

users to create, 

edit and save drive 

configuration files.

Product Overview1

 NOTE: Throughout this 
manual information that 
ONLY applies to Stepper 
Drives will be noted in grey 
box:

ACS Stepper Drive

Information that ONLY applies 
to Servo Drives will be noted 
in light blue box:

ACS Servo Drive
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1 :   P R O D U C T  O V E R V I E W

Some screens and instructions are different for the Stepper drive/controller than 
for the Servo drive/controller. The user guide indicates instructions that apply to 
Stepper only and instructions that apply to Servo only. If there is no indication, the 
information applies to all Tolomatic ACS Drive/Controllers.

ACS Stepper Drive

Figure 1-2: Example of Stepper Only information

ACS Servo Drive

Figure 1-3: Example of Servo Only information

FOR EXAMPLE: The Tuning Filter Tool (Chapter 16) is only available for the Servo Drive. 
When the servo drive is connected to the computer the software will detect the drive and 
the Tuning Filter Tool will be available. Conversely, when connected to a Stepper Drive the 
Tuning Filter Tool will NOT be available.

 NOTE:  

It is important to 

identify the motor and 

corresponding ACS 

drive system (Stepper 

or Servo) being used! 

Because the TMI 

software allows an 

offline connection 

that does not require 

the Tolomatic 

drive. This offline 

connection allows 

users to create, 

edit and save drive 

configuration files.
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ACS Stepper Drive

ACS Servo Drive

Host Computer Requirements2
2.1 Host Computer and Software System Requirements

The Tolomatic Motion Interface (TMI) is designed to work with a host PC with 
Windows® operating systems.  Before installing the TMI software, be sure the host 
PC has the minimal host requirements indicated below. 

2.1.1 Hardware Requirements

HARDWARE MINIMUM REQUIREMENT

Processor 1 GHz

RAM 512 MB

Disk Space 32-Bit 600 MB

Disk Space 64-Bit 1.5 GB

USB 1 USB Connection

Serial*  
or 

USB

1 Serial Connection  
or 

1 USB to Serial Adapter

Table 2-1: Hardware Requirements

*The ACS Stepper Drive requires a serial connection to the PC. Either through a USB 
serial adapter or plugging into a Com port on the PC.

2.1.2 Operating Systems Supported
The Tolomatic Motion Interface (TMI) is compatible with the following operating 
systems: Windows® 7, and Windows® 8.

For all platforms, it is recommended that you upgrade to the latest Windows Service 
Pack and critical updates from the Windows Update Web Site at http://go.microsoft.
com/fwlink/?LinkId=168461 to ensure the best compatibility and security.

The TMI software is not supported on IA-64-based (Itanium) systems.

http://go.microsoft.com/fwlink/?LinkId=168461
http://go.microsoft.com/fwlink/?LinkId=168461
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Installing the TMI Software 3
3.1 Installation Instructions

3.1.1 Installing from the Tolomatic CD
1.	 Insert the software CD supplied by Tolomatic into the CD-ROM drive in your PC.

2.	 Follow the link on the displayed web page to install the latest software and view 
the manuals (requires internet connection)

3.	 If internet connection is not available, browse the CD and double-click the "Tol
omaticMotionInterface[version].exe" file to run the installer. 

4.	 Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:  
Start > All Programs > Tolomatic > TolomaticMotionInterface[version] 
> TolomaticMotionInterface

In the Start menu the program will start with a single click. 

3.1.2 Downloading and Installing from the Tolomatic Web 
Site at www.tolomatic.com
The Tolomatic Motion Interface can be downloaded from the Tolomatic web site at 
www.tolomatic.com

1.	 To download, click on "Resources" in the navigation bar at top. Select 
"Electric Linear Motion" under "Select a product line below to view the 
available resources" by default the "Catalogs & Brochures" tab will open, select 
the tab: "Software" the current and archive ACS TMI software is available. 

2.	 Select the TMI software and when prompted save the file to the programs 
folder on your hard drive. 

3.	 Double-click the "setup.exe" file to run the installer. 

4.	 Follow the prompts to install the software.

The software will install a program launch icon in the Windows® Start menu at:  
Start > All Programs > Tolomatic > TolomaticMotionInterface[version] 
> TolomaticMotionInterface

In the Start menu the program will start with a single click. 
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Starting the TMI Software4
4.1 Launching the TMI Software

1.	 To launch the software in the Windows® Start menu navigate to: Start > 
All Programs > Tolomatic > TolomaticMotionInterface[version] > 
TolomaticMotionInterface

2.	 When the TMI is launched for the first time, the software will automatically 
display the User Units dialog box (shown below, Figure 4-1) which defines the 
units displayed in the software.  The user has two selections for linear actuator 
units:  inches (US Linear) or mm (SI Linear). 

Figure 4-1: User Unit Dialog Box

3.	 The user must select the desired units and click Apply.  Once the apply button 
is clicked TMI will no longer automatically display the User Units dialog box on 
application launch. To access the User Units dialog box click on the ruler icon 
in the tool bar at top. The units can be changed at any time and all displayed 
parameters in the software will be adjusted accordingly.   

Figure 4-2: User Unit Tool Icon in menu
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ACS Servo Drive

ACS Stepper Drive

Establishing Communication5
5.1 Establishing Communication with the Tolomatic ACS Drive

For stepper drives the communications protocol used for configuration uses RS-232 
cable. 

or 

For servo drives the communications protocol used for configuration uses USB 
cable. 

1.	 After the User Units have been selected on initial startup, and from then on 
once the TMI is launched, the software will automatically default to the Drive 
tab shown in Figure 5-1 below.

Figure 5-1: Drive Tab Showing ACS Drive Disconnected

2.	 When the 'Auto' option is selected for the port, TMI attempts to detect the 
presence of ACS servo or stepper drive on any of the COM ports available on 
the computer. The ACS drive must be powered on for communication with the 
PC in order for the discovery sequence to be successful. (If no ACS Drive is 
found, the status bar (at bottom) will display "Disconnected" and the text box 
will display "Unable to connect to ACS Drive" message.)  The user may also 
select a specific port from the list of available COM ports. TMI will prompt 
you to install drivers if drivers are required to connect to the drive. For proper 
operation be sure that both the TMI software and associated drivers are up-to-
date. Once successful communication is established, the TMI will remember 
that port for subsequent sessions.  The Baud rate is set to 38400 and can not 
be changed.

3.	 Upon establishing communication with the ACS Drive, the TMI software reads 
all the current settings in the ACS Drive and updates the software interface 
accordingly. As shown in Figure 5-2, the ACS Drive information is displayed 
in several fields: Name of ACS Drive given by user; ACS Drive information 
including Model and Firmware Version;  and a Photo of the Tolomatic ACS Drive 

 NOTE: The TMI 

software allows an 

offline connection 

that does not require 

the Tolomatic 

drive. This offline 

connection allows 

users to create, 

edit and save drive 

configuration files.

 NOTE: Throughout this 
manual information that 
ONLY applies to Stepper 
Drives will be noted in grey 
box:

ACS Stepper Drive

Information that ONLY applies 
to Servo Drives will be noted 
in light blue box:

ACS Servo Drive
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product being configured (ACS Drive/Controller is pictured). If the ACS Drive has 
Network hardware the MAC address will also be displayed.

Figure 5-2: Drive Tab Showing ACS Drive Connected

4.	 The TMI software opens a Software Stop window shown in Figure 5-3.  This 
Software Stop window is intended to be a software motion stop.  If the user 
clicks on the stop button, the actuator will immediately stop. The Tolomatic ACS 
Drive will be disabled along with the output to the motor.  For safety reasons 
this window is intended to always be on top of other windows.  

Figure 5-3: Software Stop
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5.2 Offline Connection
The TMI software supports an offline connection that allows the user to create, edit 
and save drive configuration files without the Tolomatic ACS Drive being present.  
This is a useful development and debug tool to create and analyze the drive 
configuration files.  

With the Offline connection, all controls related to motion, tuning and enabling/
disabling drive are disabled.  The offline connection does not allow the user to 
simulate motion, debug logic, or tune servo motors.

Figure 5-4: Offline connection
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Navigating through the TMI Software6
6.1 Navigating through the Tolomatic Motion Interface (TMI)

6.1.1 Setup Wizard Tabs
The TMI software for configuring the ACS Drive is designed as a setup wizard. It 
uses tabs, navigating from left to right through all the steps needed to configure the 
ACS Drive and create motion.  As shown below, there are multiple tabs which are 
used in the setup process.

TMI Setup Wizard Navigation Tabs

Drive Establish communication and verify ACS Drive identification information such 
as model and firmware version.

Actuator Configure a Tolomatic actuator or create a custom actuator in the “Other 
Actuator Catalog.”

Motor Configure or view parameters of a Tolomatic motor or create a 3rd party motor 
file in the “Other Motor Catalog.”

Mode 
Select 

Select the desired operating mode.  Tolomatic ACS Drive products were 
designed to have dedicated operating modes to simplify the configuration 
and operation of the ACS Drive.  Currently, there are four operating modes, 
depending on model:  Index Move, Pneumatic, Analog Position and Network 
(EtherNet/IP, ModbusTCP, Modbus RTU)

I/O Configure the functionality of the digital inputs and digital outputs of the ACS 
Drive.  The TMI will automatically configure a suggested I/O map based on the 
selected operating mode. 

Fault Enable/disable faults, and configure the action taken for the displayed faults.

Safety/
Limits

Configure safety parameters and motion limits such as:  in position, position 
error, maximum velocity/accel/decel, current limit, software limits and zone 
bounds

Home 
Setup

Configure the homing routine parameters such as type, direction, velocity, 
force, and home on power-up.

Mode 
Setup

Setup the operating Mode selected in the Mode Setup tab.  For example, 
in Index Move mode, the user configures move type, position, velocity, 
acceleration, deceleration and force for all the moves.  

Table 6-1: TMI Setup Wizard Navigation Tabs

6.1.2  Tolomatic Logo
The TMI software uses the Tolomatic Logo  
to guide the user through the software in order to correctly configure all necessary 
parameters.  Notice in the drawing above that the ACS Drive is connected, the 
Tolomatic logo has moved to the Actuator tab which is the next required step–
configuring the actuator.  The Drive tab remains highlighted in Blue which gives the 
user visual indication of the currently selected tab.  
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6.1.3 Tool Bar

Figure 6-1: Tolomatic Motion Interface (TMI) Tool Bar

The Tool Bar includes the following:  

Drive Connect:  Connect or disconnect communication to the ACS 
Drive.

Ethernet Setup (optional):  Set up ACS Drive for Ethernet 
communication.

Open:  Open a previously saved drive configuration file to setup all the 
parameters of the ACS Drive.  

Save:  Save all parameters to a drive configuration file for later use.

Restore Current Settings from Drive Flash:  Read all parameters 
from drive flash memory into the TMI software.

Write Current Settings to Drive Flash:  Write all parameters from 
the TMI software into the drive flash memory.

Software Stop:  Disables ACS Drive and output to the motor

Home:  Initiates a home routine

 
Motion Manager tool:  Tool used to create simple moves such as 
absolute, incremental and jog.  All motion profile parameters are 
adjustable through this tool.  
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ACS Servo Drive Tuning Filter tool:  Tool used to tune servo motors (advanced users)

Drive Status tool:  Tool used to notify user of critical drive information 
such as Enable status, Home status, In Position status and Faults (see 
Section 20: Drive Status Tool). 

Digital I/O tool:  Tool used to view the status of the Digital Inputs and 
Digital Outputs (see Section 17: Digital I/O Tool).

Analog I/O tool:  Tool used to view the status of the Analog Inputs and 
Analog Outputs (see Section 18 Analog I/O Tool).

 

4 Channel Software Oscilloscope:  Tool used to view signals on the 
drive.

 
User Units tool:  Tool to select application user units.  At time of this 
release, units are selected in inches or millimeters.

	

6.1.4 Tool Tips
As the user moves the mouse over Tool Bar items, drive parameters or action 
buttons, the TMI will display a tool tip providing useful information about that item.  

 
Figure 6-2: Tool Tips Display 

Tool Tip Displays:  Moving the mouse over a parameter field will activate the 
Tool Tips display and it will show the allowable range for that parameter. If a 
user attempts to enter a lower number than is allowed, the TMI software will 
automatically default to the minimum allowable value.  If a user attempts to enter a 
higher number than is allowed, the TMI will automatically default to the maximum 
allowable value.  

 
Figure 6-3: Parameter Range in Tool Tip Display
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6.1.5 Parameter Entry
Red Parameter Field:  The TMI will automatically shade any parameter field a red 
color if that parameter has not been configured (see Figure 6-4).  This is a notice to 
the user that this parameter must be configured before continuing or creating motion.  

Figure 6-4: Red Parameter Fields

6.1.6 File Menu

Figure 6-5: File Menu Options

File Menu Drop Down Descriptions

Open Open a drive configuration file to setup all the parameters of the 
ACS Drive.

Save Saves all parameters to a drive configuration file. If user hasn't 
given a name to the file yet, a File Save window will be opened.

Save As Opens a File Save window to allow user to select location and name 
of drive configuration file.

Write Current Settings 
to Drive Flash

Write all parameters from the TMI software into the drive flash 
memory.

Read Current Settings 
from Drive Flash

Read all parameters from drive flash memory into the drive's RAM 
and into the TMI software.

Restore Drive to 
Factory Settings

Restores all parameters in the ACS Drive flash and RAM memory to 
factory defaults. 

Read Current Settings 
from Drive RAM

Reads all parameters in ACS Drive RAM into the TMI software 
(Performed automatically when communication is established)

Exit Exits the application

Table 6-2: File Menu Drop Down Descriptions

 NOTE: Executing any 
Open, Restore or Read 
operation will result 
in the TMI software 
automatically navigating 
to the Drive Tab and 
updating all parameters 
in TMI to the current 
drive settings.
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ACS Servo Drive

6.1.7 Tools Menu 

Figure 6-6: Tools Menu

Tools Menu Drop Down Descriptions
Motion Manager Used to create simple moves such as absolute, incremental and 

jog.  All motion profile parameters are adjustable through the Motion 
Manager tool.  

Tuning Filter Tool used to tune servo motors

Drive Status Used to notify user of critical drive information such as Enable 
status, Home status, In Position status and Faults

Digital I/O Used to view the status of the Digital Inputs and Digital Outputs.

Analog I/O Used to view the status of the Analog Inputs and Analog Outputs.

4 Channel Software 
Oscilloscope

Software tool used to analyze drive parameters

User Units Used to select application user units.  At time of this release, units 
are selected in inches or millimeters.

Software Stop Used to disable ACS Drive and output to the motor.  This tool is 
automatically launched when the TMI software connects to the ACS 
Drive.

Ethernet Setup 
(optional)

Set up ACS Drive for Ethernet communication.

Advanced Diagnostics Tools used for advanced diagnostics and troubleshooting.

Upgrade ACS 
Firmware

Used to upgrade the firmware for the ACS. 

Table 6-3: Tools Menu Drop Down Descriptions
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6.1.8 Help Menu

Figure 6-7: Help Menu Drop Down Options

Install ACS Drivers: Installs the drivers for the USB enabled ACS Drives.

ACS Stepper Hardware & Installation Guide: Launches a PDF of the manual 
with ACS Stepper Drive specifications, wiring diagrams, connector and cable 
information.

ACS Servo Hardware & Installation Guide: Launches a PDF of the manual with 
ACS Servo Drive specifications, wiring diagrams, connector and cable information.

Tolomatic Motion Interface (TMI) Software Guide: Launches a PDF of this 
manual. 

ACS [Network Mode] Manual: Launches a drive specific PDF of the manual for 
supported network mode. 

About: Indicates the current software version of the Tolomatic Motion Interface and 
the build date.

Email Problem Report: Launches local email application with log file attachments 
that can be sent to Tolomatic in the event of an issue. 

 
 

Figure 6-8: About Window 
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Actuator The Actuator Tab 7
The Actuator tab is used to configure a Tolomatic actuator or define a new actuator.  
The default selection of the radio button is Tolomatic Actuator.

7.1.1 Tolomatic Actuator Selection
1.	 Identify the actuator configuration string on the actuator.  Enter Model, Size, 

Screw/Nut Lead, Stroke Units (either SM for mm, or SK for inches), length of 
Stroke in units specified, Motor Mount, and Motor option.  

Figure 7-1: Configuration string on ERD actuator

2.	 When Model is configured, a photo of the actuator will be shown.  (Note: ALL 
Tolomatic electric actuators can be selected from the model drop down menu.)

Figure 7-2: Configuring the Tolomatic Actuator Selection

 NOTE: When complete configuration string is entered the Tolomatic logo will 
move to the next tab requiring attention.

3.	 Copy to Other Actuator: Creates a new actuator in the Other Actuator Selection 
based on the defined Tolomatic Actuator.

7.1.2 Other Actuator Selection
The Other Actuator Catalog allows a user to keep any number of Other Actuator 
models in the file for convenience and later reference.

7.1 Using the Actuator Tab

 NOTE: ALL 

Tolomatic electric 

actuators can be 

selected from the 

model drop down 

menu.
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1.	 If no Other Actuators have been created there will be no selections under the 
Models drop down.  In this case, the user must click the New button at the 
bottom of the screen (see Figure 7-3).

Figure 7-3: Selection of Other Actuators

2.	 Clicking the New button, will bring up a New Actuator dialog in which the user 
must enter critical information about the actuator (see figure 7-4)

3.	 Model field:  Enter the name selected for the Other Actuator.  It will remain red 
until the user enters a unique name that has not already been saved into the 
Other Actuator Catalog.  

4.	 Description field:  Enter a unique description of the Other Actuator, up to a 28 
alpha-numeric character entry that is all uppercase. This field is optional.

5.	 Stroke field:  Enter the stroke in the selected user units.  There is no stroke 
limit for Other Actuators.

Figure 7-4: New Actuator Window

6.	 Linear Units Ratio field: These numerator and denominator entries are used to 
setup the ratio of rotary motor revolutions to linear distance in selected user 
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units per motor revolution. If there is a gearbox inline with the motor, this ratio 
must be taken into account and entered accordingly.  

	 For example, if there is an Other Actuator with an 0.5" lead screw, then the 
Linear Units Ratio would look as in Figure 7-5 below.  All the required fields 
have been entered properly and the parameters have been validated. This  
activates the Save button. 

Figure 7-5: New Actuator Window Data Entry Complete

	

7.	 Clicking the save button adds the New Actuator information to the Other 
Actuator catalog. The name of the new actuator is automatically added to the 
Model drop down for later reference.  

Figure 7-6: Other Actuator Window with Multiple Model Drop Down Display

8.	 Button descriptions:  
New: 	 Create new actuator 
Edit: 	 Edit existing actuator previously saved 
Delete: 	Delete selected actuator 
Copy: 	 Create a new actuator based on selected existing actuator
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Motor

ACS Stepper Drive

The Motor tab is used to configure a Tolomatic motor or create a different motor in 
the Other Motor Catalog. The default selection of the radio button is Tolomatic Motor.  

8.1.1 Tolomatic Motor Selection
1.	 Verify the correct Motor selection and settings are displayed.  

2.	 All parameters except the Reverse Direction check box are automatically 
populated with those of the selected motor and are disabled from entry.  

	 If the user wishes to select a different motor Model that is acceptable for the 
actuator chosen, then simply select a new motor from the Model drop down.  

3.	 Depending on the actuator configuration or the actuator installation in the 
machine, the user may wish to reverse the direction of the motor's positive 
direction. Default positive motion direction is CW (clockwise) when viewed 
toward output shaft of motor. To change it to CCW (counter-clockwise), the 
Reverse Direction check box must be checked.

Figure 8-1: Motor Tab with Tolomatic Stepper Motor Selected

The Motor Tab8
8.1 Using the Motor Tab



ACS Servo Drive
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Figure 8-2: Motor Tab with Tolomatic Servo Motor Selected

 NOTE:  Servo does not currently support "Other Motor".
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ACS Stepper Drive
8.1.2 Other Motor Selection

The Other Motor catalog allows a user to keep any number of motor models 
compatible with the ACS Drive in the file for convenience and later use.  Selection 
of a motor other than one supplied by Tolomatic is done in a similar procedure as 
selecting an Other Actuator.

1.	 If no Other Motors have been created there will be no selections under the 
Models drop down (see Figure 8-3). In this case, the user must click the New 
button at the bottom of the screen.

Figure 8-3: Other Motor with no Model Choices Available

2.	 Clicking the New button, will bring up a New Stepper Motor dialog box in which 
the user must enter the motor name, description (28 alpha-numeric characters 
in uppercase), and specifications. Once the information entered has been 
validated, the light red fields will disappear and the save button will become 
active.

3.	 Clicking the save button adds the New Motor information to the Other Motor 
catalog. The name of the new motor is automatically added to the Model drop 
down for later reference.  

4.	 Depending on the actuator configuration or the actuator installation in the 
machine, the user may wish to reverse the direction of the motor's positive 
direction. When facing motor mounting end, default positive motion direction is 
CW (clockwise). To change it to CCW (counter-clockwise), the Reverse Direction 
check box must be checked.
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ACS Stepper Drive

Figure 8-4: Edit Stepper Motor Window with Data Complete

Figure 8-5: Other Motor Window with Model Added to Drop Down Display

5.	 Button descriptions:     New: Create new actuator   Edit: Edit existing actuator 
previously saved   Delete: Delete selected actuator   Copy: Create a new 
actuator based on selected existing actuator
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Mode Select The Mode Select Tab 9
9.1 Using the Mode Select Tab

The software supports four different operating modes:  Index Move, Analog 
Position, Pneumatic and Network.  Network mode supports one of the 
following protocols: Modbus RTU, EtherNet/IP or Modbus TCP.

The Index Move mode supports 4, 8, and 16 move commands.  These 
move commands can be configured to be Absolute, Incremental, Jog, 
Home or No Action moves.  The motion profile can be independently set for 
each move.  The motion profile includes velocity, acceleration, deceleration 
and force which is setup in the Mode Setup tab (see Section 14:  Mode 
Setup Tab).

The Analog Position mode supports both voltage (0 to 10 VDC) and 
current (0 to 20 mA) on the analog input and analog output.  The ACS 
Drive follows the analog input signal and commands the actuator position 
to a scaled position as distance/volt.

The Pneumatic mode is used to replace or mimic pneumatic cylinder/
valve operation logic. With pneumatic mode there are four different 
selections: Spring, 2 Position (2 input), 3 Position (2 input) &, 3 Position 
(3 input). These four pneumatic mode operations allow just about any 
pneumatic valve logic to be replaced with the ACS drive. Additionally, in 
pneumatic mode, the drive will automatically home the actuator upon 
power up based on the home setup configuration.

The Network mode supports one of the Modbus RTU, EtherNet/IP or 
Modbus TCP protocols. The ACS Drive can then accept commands to 
change motion profile, command infinite positions, monitor status and 
provide diagnostics.

Figure 9-1: Mode Select Tab Window - Index default

 NOTE: The ACS stepper drive 
models and modes are as follows:

ACS 
Model Number Mode

24
V 

St
ep

pe
r

ST0324SD 3604-9651

Index Move 
Analog Position 

Pneumatic 
Modbus RTU

ST0324ED 3604-9654

Index Move 
Analog Position 

Pneumatic 
EtherNet/IP

ST0324MD 3604-9655

Index Move 
Analog Position 

Pneumatic 
Modbus TCP

 NOTE: The ACS servo drive 
models and modes are as follows:

ACS 
Model Number Mode

24
V 

- 
48

V 
Se

rv
o

SV2048UD 3604-9661

Index Move 
Analog Position 

Pneumatic 
Modbus RTU

SV2048ED 3604-9662

Index Move 
Analog Position 

Pneumatic 
EtherNet/IP

SV2048MD 3604-9663

Index Move 
Analog Position 

Pneumatic 
Modbus TCP
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Figure 9-2: Mode Select Tab Window - Index drop-down

Figure 9-3: Mode Select Tab Window - Analog default

Figure 9-4: Mode Select Tab Window - Analog drop-down

Figure 9-5: Mode Select Tab Window - Pneumatic drop-down

 NOTE: The 

TMI software will 

determine if ModBus 

RTU, EtherNet/IP 

or Modbus TCP is 

appropriate based on 

the connected ACS 

Drive and firmware 

version.
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Figure 9-6: Mode Select Tab Window - Modbus RTU

Figure 9-7: Mode Select Tab Window - EtherNet/IP

Figure 9-8: Mode Select Tab Window - Modbus TCP
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I/O The I/O Tab10
10.1 Using the I/O Tab

The digital input and digital output functionality are configured using the I/O tab. 
Default I/O configurations are set up for the selected mode and are shown after the 
Digital Input and Output Command Tables in Figures 10-1 through 10-4.

10.1.1 Digital Inputs

Digital Input Functionality
Enable Enables or Disables the ACS Drive and power to the motor.  

NOTE:  Faults configured to Disable Motor (see Section 11: Fault 
Tab) will require PLC or logic device to cycle level of Enable input 
to re-enable the ACS Drive. Cycling this input when there is no 
feedback device will clear the Home output.

Start Motion Initiates the selected move command from the  
Move Select inputs.

Stop Motion Stops move in progress with controlled deceleration.

Home Initiates the homing routine setup in the Home Setup tab (see 
Section 13: Home Setup Tab).

Software-stop Executes an immediate stop which either stops motion or 
disables ACS Drive depending on the fault configuration in the 
Fault tab (see Section 11: Fault Tab). While asserted it prevents 
further motion.

Move Select 1-4 Inputs Selects move for execution based on  
Index Move mode (see Appendix 2 for Move Select Logic) or 
Pneumatic mode (see Appendix 3 for Move Select Logic)

Positive Limit Switch Stops motion or disables the ACS Drive depending on the fault 
configuration in the Fault tab (see Section 11: Fault Tab). 

Negative Limit Switch Stops motion or disables the ACS Drive depending on the fault 
configuration in the Fault tab (see Section 11: Fault Tab).

Table 10-1: Descriptions of Digital Input Functionality

Refer to Appendix 1: I/O Timing Diagrams for Input Requirement, System Startup 
Timing, Jog Move Timing, Absolute and Incremental Moves, Timing and Move  
Timing Rules.

10.1.2 Digital Outputs

Digital Output Functionality
Motion Complete Signal to PLC or logic device indicating whether motion is in 

progress (off) or motion is complete (on).

Home Complete Signal to PLC or logic device indicating whether ACS Drive/
motor combination is homed (on) or not homed (off).  NOTE:  
When homing is in progress, the Home Complete output will 
be off.
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Digital Output Functionality
Fault Signal to PLC or logic device indicating that a fault has 

occurred.  The steps to reset the fault are different depending 
on the fault category (see section 11: Fault Tab) for a complete 
description of faults and recovery.

Zone 
(Optional)

Signal to PLC or logic device indicating that the position of the 
actuator is within the Zone Positive Bound and Zone Negative 
Bound setup in the Safety/Limits tab (see Section 12: Safety/
Limits Tab).

Table 10-2: Descriptions of Digital Output Commands

Refer to Appendix 1: I/O Timing Diagrams for Input Requirement, System Startup 
Timing, Jog Move Timing, Absolute and Incremental Moves, Timing and Move  
Timing Rules.

Digital Input Control
TMI allows the user to adjust the digital debounce time from 0 to 500 milliseconds. 
(This control is not pictured)

10.1.3 Default Configurations for Operating Modes

Figure 10-1: Default Configuration and Options for 4 Index Move Command
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Figure 10-2: Default Configuration and Options for 8 Index Move Command

Figure 10-3: Default configuration and Options for 16 Index Move Command
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Figure 10-4: Default configuration and Options for Analog Position mode

Figure 10-5: Default configuration and Options for Pneumatic mode
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Figure 10-6: Default configuration and Options for Network modes (one of these 
protocols: Modbus RTU, EtherNet/IP or Modbus TCP)

10.1.4 Brake Output Configuration
For drives that support brake output, control of the output is configured on the I/O 
tab.

Figure 10-7: Brake Output enabled
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Brake Output Functionality
Enable Brake Output Enables or disables the brake output subsystem

Active Low Brake is applied when current is removed

Active High Brake is applied when current is applied

Disable Brake Response 
Delay

Number between 0 and 1,000 milliseconds

Enable Brake Response 
Delay

Number between 0 and 1,000 milliseconds

Maximum Brake Delay Number between 0 and 1,000 milliseconds

Maximum Brake Velocity Number between 0 and 5 mm/sec.

Table 10-3: Descriptions of Brake Output Functionality

Figure 10-8: Brake Output timing
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Fault The Fault Tab11
11.1 Using the Fault Tab

The Fault tab allows the user to configure how the drive responds to Safety Faults.  
The Critical Faults are always enabled and the configured response is to disable the 
motor.  Critical Faults are listed for information only.

Each of the Safety Fault types has a check-box and a combobox (drop-down).

Figure 11-1: Safety Fault - user defined choices

Each available Safety Fault has 4 different user defined choices. (If greyed out 
no input is configured for that safety fault.) Safety Faults are assigned to physical 
digital inputs in the I/O tab.  If that digital input is High, then the assigned Fault 
condition will occur.

Unchecked Input will not cause a safety fault.

Checked, Stop 
Motion

Fault will result in current motion to stop at Maximum 
Decel value configured on the Safety/Limits tab, and the 
Fault digital output will be turned on.  A subsequent motion 
command may automatically clear this fault.

Checked, Disable 
Motor

Fault will result in drive power to be cut.  If a move is in 
progress, coasting may result.  For a vertical application, the 
load may fall.  The motor will remain disabled until the 
fault is cleared by an ACS Drive Disable/Enable cycle, or 
power cycle.

Checked, Stop 
Motion (without 
Fault Output)

Same as “Checked, Stop Motion” except the Fault digital 
output will not be turned on.

Table 11-1: Safety Fault user defined choices

NOTE: Maximum Decel 

is used in Safety Faults 

when either Stop 

Motion & Stop Motion 

(without Fault Output) 

is chosen. This allows 

a faster motion stop 

than Disable Motor. (See 

Chapter 12 Safety/Limits 

Tab)
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11.2.1 Safety Faults
Positive Limit Switch Enabled if a limit switch digital input is configured on the 
I/O tab.

Negative Limit Switch Enabled if a limit switch digital input is configured on the 
I/O tab.

Position Error safety fault is only enabled if the configured Motor has an encoder 
(configured on the Motor tab). Motion Limits must also be configured in the Safety 
Limits Tab. 

Software Stop

These are optional, and if no associated digital input is configured (on the I/O tab), 
the check-box and combobox will be disabled.

Safety Faults Table
Positive Limit 
Switch

Fault indicates positive limit has been reached. If Stop Motion is 
configured, the fault will clear on motion in the opposite direction. If 
Disable Motor is configured, the fault is cleared with Disable/Enable cycle.

Negative Limit 
Switch

Fault indicates negative limit has been reached.  If Stop Motion is 
configured, the fault will clear on motion in the opposite direction. If 
Disable Motor is configured, the fault is cleared with Disable/Enable cycle.

Position Error Requires motor with an encoder. Fault indicates current position is not 
within the specified Position Error distance (configured on the Safety/
Limits tab) of the commanded position. If Stop Motion is configured, this 
fault will be automatically cleared on the next move. If Disable Motor is 
configured, the fault is cleared with Disable/Enable cycle.

Software Stop Fault indicates the signal level on the digital input is high. If Stop Motion 
is configured it will be cleared once the software stop input is lowered. 
Motion will not be allowed until software stop has been cleared. If Disable 
Motor is configured the fault must be cleared by lowering software stop 
input, and cycle enable signal.

Table 11-2: Safety Faults Descriptions

Figure 11-2: No associated digital input means Safety Fault cannot be configured and are 
displayed greyed out on Fault Tab

 NOTE: To clear 

faults that disable the 

motor; PLC needs to  

lower/raise the enable 

digital input, toggle 

the enable bit using 

Network or TMI user 

must press the Enable 

button on the motion 

manager.

11.2	  Fault Descriptions and Recovery
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ACS Servo Drive

ACS Stepper Drive

11.2.2 Critical Faults
All Critical Faults will disable the motor when they occur. To clear these faults, the 
fault condition cannot be present and the enable input line must be lowered and 
then raised to proceed with motion.  Watchdog timeout must be cleared by power 
cycle only.

Stepper Drive Critical Faults Table
Feedback Error Feedback device is malfunctioning.

Over Current If a short circuit occurs from output to ground, this fault will be 
triggered.

Motor Over Temp Not implemented in this release.

Drive Over Temp Drive temperature is greater than the maximum allowed 
temperature (75˚C).

Drive Over Voltage Main power voltage exceeds the maximum voltage. 

Drive Under Voltage Main power voltage below the minimum voltage. 

Table 11-3: Stepper Drive Critical Faults Descriptions

Servo Drive Critical Faults Table
Feedback Error Feedback device is malfunctioning OR disconnected when drive 

is enabled. (Power Cycle to Clear) or motor is overTemp

Over Current Drive current is above safe level for the Drive hardware.

Drive Over Temperature Drive temperature is greater than the maximum allowed 
temperature (75˚C).

Drive Over Voltage Main power voltage exceeds the maximum voltage.  (75V)

Drive Under Voltage Main power voltage below the minimum voltage.   (9V)

Flash Error Flash write failed. Flash version doesn't match.

I2T Limit Drive power usage above maximum allowed.

Short Circuit Motor phase shorted to ground. Internal motor short or phase 
short to ground.

Watchdog Timeout Firmware stall, drive reset or drive power-cycled but voltage did 
not reach ØV. (Power Cycle to Clear)

Table 11-4: Servo Drive Critical Faults Descriptions

 NOTE: To clear 

faults; PLC needs to  

lower/raise the enable 

digital input, enable bit 

using EtherNet/IP or 

TMI user must press 

the Enable button on 

the motion manager.
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Safety/Limits The Safety/Limits Tab12
12.1 Using the Safety/Limits Tab

The Safety/Limits tab is used to configure Safety parameters, Motion Limits and 
setup such features as Endpoint Correction or Zone Output.  

Figure 12-1: Safety/Limits Tab

12.1.1 In Position Criteria
In Position:  This value defines the +/- window around the desired target position 
that is considered within position.

Settle Time:  The amount of time the position is within the In Position Band before 
declaring Motion Complete.

Endpoint Correction:  When enabled, Endpoint Correction initiates one correcting 
move at the end of the initial move to correct any position error that is greater than 
the In Position value. At the end of the initial move, the distance of the corrected 
move will be the difference between Target Position and Actual Position. This 
correcting move will use the same motion profile parameters (velocity, accel, decel, 
force) as the initial move. Endpoint Correction is only available with stepper motors 
with encoders.  

Force Move Settle Time:  The amount of time after a specified force is reached 
before declaring Motion Complete.

 NOTE: Throughout this 
manual information that 
ONLY applies to Stepper 
Drives will be noted in grey 
box:

ACS Stepper Drive

Information that ONLY applies 
to Servo Drives will be noted 
in light blue box:

ACS Servo Drive

Force Move Settle Time
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12.1.2 Position Error
This value defines the +/- window around the commanded position that the actual 
position must be within or a Position Error fault will occur. 

Position Error = Commanded Position – Actual Position. 

The Position Error is continuously calculated throughout the entire move. Position 
Error is only available with motors with encoders. The Position Error setting must 
always be larger than the setting for the In Position parameter. If the Position Error 
setting is smaller than the In Position setting, the In Position parameter will turn red, 
indicating an invalid setting.

12.1.3 Eco Mode  
Eco mode is intended to reduce motor current in the motion complete interval 
(dwell) by allowing a slight increase of position error. It is suggested to enable this 
feature when an I2T Fault occurs when the drive is not in motion, or if there is high 
drag in the mechanical system and the drive is near the I2T Limit.

Eco mode is a mode specially designed for instance where the dynamic loads on 
the actuator are lower than the stiction or drag of the mechanical system itself.  
In other words, if the drive is disabled, the load does not move from its current 
position.  

In these high drag mechanical configurations, frictional drag may prevent position 
error from ever reaching 0.  As the control loop error increases over time, it 
eventually breaks through the frictional drag and overshoots the target position.  
This process repeats and a scenario called “Position Hunting” occurs. 

Figure 12-2: Position Hunting in a High Mechanical Drag System

 While this hunting is occurring, current is increasing and, depending on the 
strength of the mechanical stiction of the system, integral error could be spooling 
up over the continuous current limits of the drive or motor.  When the actual current 
is higher than the continuous current of the motor, an I2T fault can occur, which 
protects your motor and drive from overheating.  If this is occurring, your actual 
output currents could well be approaching the peak limits of the drive or motor.  
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When Eco mode is enabled, motion is complete and the current position is within 
the In Position Band, the control loop does not attempt to correct position error.  
This allows the mechanical advantage of the system to hold the load while the drive 
monitors the position and intercedes when the current position falls outside of the In 
Position Band.  This mode conserves power by stopping the Position Hunt.

Figure 12-3: Eco Mode Enabled on a High Drag Mechanical System

While Eco mode is primarily used in systems with mechanical high drag, it also can 
be used in systems that do not have high drag, but wish to conserve power – at a 
cost of a slight position adjustment on motion complete.  In these systems, the load 
pushes the Current Position outside of the In Position Band.  The Control Loop then 
corrects the position using a scaling based on target position and the position error 
limit.  As the current position approaches the position error limit the control gains 
increase.  This negotiation results in a rapid equilibrium that conserves power.

Figure 12-4: Eco Mode with Position reaching equilibrium

TIPS:   1) The smaller IN Position Band is the less effective ECO Mode, it will be 
reducing power during the motion complete interval.

2) Control gains are scaled at maximum 100% at the position error limit. To reduce 
position error when in motion complete interval, reduce position error limit value.
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ACS Servo Drive

ACS Stepper Drive

NOTE: Maximum Decel 

is used in Safety Faults 

when either Stop 

Motion & Stop Motion 

(without Fault Output) 

is chosen. This allows 

a faster motion stop 

than Disable Motor. (See 

Chapter 11 Fault Tab)

12.1.4 Motion Limits
Maximum Velocity:  This value defines the maximum velocity that is allowed to be 
configured by the software and commanded by the ACS Drive. The TMI software will 
automatically cap any entered velocity value to the max setting. When the actuator 
& motor information is entered, the TMI software will automatically calculate the 
Maximum Velocity setting using the actuator max speed and motor max RPM. The 
ACS Drive ensures that no moves can be commanded with a velocity value higher 
than the max setting.

Maximum Accel/Decel:  This value defines the maximum accelerations and 
decelerations that are allowed to be configured by the software and commanded 
by the ACS Drive. The TMI software will automatically cap any entered value to the 
maximum Accel/Decel setting. The maximum allowable Accel/Decel is 40 times 
the maximum allowable velocity. The ACS Drive ensures that no moves can be 
commanded with an acceleration or deceleration value higher than the value of the 
Maximum Accel/Decel parameter. 

	 Note:  If zero (Ø) velocity or accel/decel is entered, these parameters will turn 
red and the Tolomatic logo will appear on the Safety/Limits tab.

12.1.5 Current Limits
Peak Current Max:  Instantaneous current the drive is allowed to supply to the 
motor. This corresponds to 100% force in a move.

Continuous Current Max:  Maximum continuous current the drive is allowed to 
supply the motor.  

Peak Current Duration:  Maximum length of time the drive is allowed to supply 
Peak Current to the motor. This is used for the I2T Fault calculation.  

Holding Current:  This value defines the current level (in percentage) to which the 
ACS Drive sets the output current to the motor when any move is complete. The 
ACS Drive maintains this current level to the motor until the next Move Command 
is executed. The default value for this parameter is 100%. This parameter can be 
used to conserve energy while the motor is at rest.

Peak Current Max: This value defines the maximum current applied to the motor 
for all moves. Force % for a move is scaled to this value for any defined Move 
Command in the Mode Setup Tab. The limits are automatically set by the motor 
selection and definition in the Motor Tab.  The value cannot be set higher than the 
maximum rating of the motor/drive combination, but it can be reduced.
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ACS Servo Drive

Figure 12-5: Peak Current Max. 

Continuous Current Max (Servo Only): This value defines the maximum 
continuous current that can be applied to the motor/Drive combination.

Figure 12-6: Continuous Current Max.



 Tolomatic User Guide:           Motion Control Interface
 •  12_6  •

DISCONTINUED Product Style, 
Size or Part no. This guide is for 
reference only. See 3604-4184 

for current ACS Tolomatic Motion 
Interface (TMI) Guide

12 :   T H E  S A F E T Y / L I M I T S  T A BSafety/Limits

12.1.6 Positive/Negative Limits
Software Limits: There are two software limits, a positive and a negative. These 
software limits create a virtual position boundary for the motor/actuator system 
which the ACS Drive can not be commanded to exceed. The exception to this rule 
is for homing. A home command will ignore both software limits and will ignore 
limit switches if move to hard stop is selected. The TMI software will automatically 
cap any move to the positive software limit if the entered value is larger, or to the 
negative software limit if the entered value is smaller. The default values of the 
software limits are dependent upon the following homing sequences:

1.	 Home to Hard-stop

	 Negative home direction:  Positive Software Limit = Stroke – Home Offset;  
Negative Software Limit = - Home Offset

	 Positive home direction:  Positive Software Limit = + Home Offset;  Negative 
Software Limit = - Stroke + Home Offset

2.	 Home to Limit Switch

	 Negative Software Limit = - Stroke;  Positive Software Limit = + Stroke

	 Note:  The software limits must be changed to restrict motion bounds.

Zone Bounds: This feature is only visible if the Zone output is enabled on the I/O 
tab (see Section 10: I/O Tab). There are two zone bounds, a positive and a negative.  
These zone bounds define a virtual position window that is monitored at all times 
by the ACS Drive. When the actual position is greater than or equal to the Negative 
Bound Zone and less than the Positive Bound Zone, the Zone Output will be on. The 
TMI software has rules regarding these zones. The Zone Positive Bound is always 
smaller than the Positive Software Limit but larger than the Negative Software 
Limit. The Zone Negative Bound is always larger than the Negative Software Limit 
but smaller than the Positive Software Limit. The Zone Output feature does not 
interfere with motion. This feature can be used in a variety of applications to prevent  
a collision with another axis of motion or to initiate a process during a specific 
position range.     

Positive
Bound

Positive
Software Limit

Zone Output
ON

OFF

<Negative
Bound

Negative
Software Limit< <

Figure 12-7: Zone Bounds Diagram
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Home Setup The Home Setup Tab13
13.1 Using the Home Setup Tab

The Home Setup tab is used to configure the homing routine. Every home routine 
has a configurable motion profile (velocity, accel/decel, force), a choice of direction, 
and an option to home on power-up.

Figure 13-1: Home Setup Tab

Status Bar Indicators have been added to the status bar to indicate when a Fault 
condition exists (red light on the ACS drive flashing) or when the current actuator 
position is within the In Position criteria of the currently programmed software limit.

  •	 Double-clicking on the Yellow indicator will navigate to the Safety/Limits tab 
so you can review the currently programmed Software Limits and In Position 
Criteria.

  •	 Double-clicking on the Red indicator will display the Drive Status window.

13.1.1 Method of Homing
There are two different types of homing routines:  

Homing To Hard Stop

1.	 With encoder:  This home routine uses the encoder to detect position error to 
find the hard stop during home. 

2.	 Without encoder:  This home routine initiates an incremental move the size 
of one stroke length. This ensures that the actuator will find the hard stop 
since there is no encoder to help detect it. Warning: Depending on where the 
actuator is positioned when homing begins, this routine may cause the motor/
actuator to push against the hard stop for several seconds. This is not ideal for 
the mechanical system and may cause audible noise.

 NOTE: To ensure repeatability it is best to home with relatively slow velocity (<=1"/
sec or 25 mm/sec) and relatively high accel/decel (>40"/sec2 or 1000mm/sec2).
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Homing to Limit Switch

The To Limit Switch homing routine is only available if the Positive or Negative Limit 
Switch is configured in the I/O tab (see Section 10: I/O Tab). This home routine uses 
either the positive or negative limit switch to find home position. The ACS Drive 
initiates an incremental move the size of one stroke length and stops motion when 
the limit switch input is activated. 

 NOTE: To ensure repeatability it is best to home with relatively slow velocity (<=1"/
sec or 25 mm/sec) and relatively high accel/decel (>40"/sec2 or 1000mm/sec2).

13.1.2 Direction of Motion
Positive or Negative:  Depending on the setup of the motor in the Motor tab (see 
Section 8: Motor Tab), this selection will define the direction the motor/actuator 
system homes.

13.1.3 Motion Profile & Offset   
Velocity to Hard Stop / Limit Switch:  Velocity used in the initial move towards 
the hard stop or limit switch.

Velocity to Offset:  Velocity used when reversing direction to the Offset.

Accel / Decel:  Acceleration and Deceleration setting for all moves in the homing 
routine.

 NOTE: Tolomatic recommends a slow smooth homing Velocity/Accel.  Fast 
homing to hard-stop can damage your actuator.

Offset:  Distance to move away from either hard stop or limit switch in the opposite 
direction selected by Direction of Motion.

Force:  Force % setting for all moves in the homing routine.

13.1.4 Controls
Home: Initiates the Home sequence.

Enabled and Homed: Status LEDs.

Position: Indicates current position in user units.

 

13.1.5 Additional Settings 

Automatically Home on Power Up: This feature homes the system automatically 
when the ACS Drive unit is powered up.  

 NOTE:  The Enable input must be activated for the home routine to start.

 NOTE:  This feature will not work when the ACS Drive is in Network mode.
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STOP input: if during homing motion the STOP input is set, it will act like a 'home 
here'. It will decelerate at the homing deceleration value and then reset the position 
to 0.0 and show 'homed' status.

Software STOP input: if during homing the Software STOP input is set, it will stop 
the homing motion and declared 'unhomed' status. The same action will be taken if 
a fault occurs during homing.  

 NOTE: Position is cleared to 0.0 at the hard-stop/limit switch, and again when 
finished the offset move.
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Mode Setup The Mode Setup Tab14
The Mode Setup tab is used for configuring the selected mode in the Mode Select 
tab (see Section 9: Mode Select Tab ).

14.1 Index Move Mode
With the Index Move mode, there are three different selections: 4, 8 & 16 Move 
Commands. If the ACS Drive has not been previously configured or it has been 
restored to factory defaults, the Move Commands will be configured with zero 
velocity, accel & decel to prevent any motion. The velocity, accel and decel fields will 
be highlighted in light indicating they are invalid settings (see table below). 

The setup table used for the 4, 8 & 16 Move Commands mode has the following 
columns: Label, Move Type, Position, Velocity, Accel, Decel and Force.  Each individual 
Move Command (rows) can have different, independent settings for each column.  

Setup Table Move Definitions
Label Descriptive alpha-numeric “name” for each Move Command.  Limited to 28 

characters, all uppercase.
Move Type Drop down selection for the type of move for each Move Command.  Valid 

selections are Absolute (default), IncrPos, IncrNeg, JogPos, JogNeg, Home and No 
Action.  If an encoder is present, all moves are validated with the encoder feedback.  
If no encoder is present, the move is operated in open loop with no feedback.

Absolute: Initiates an absolute move upon the Start Motion Input.

IncrPos: Initiates an incremental move in the positive direction upon the Start 
Motion Input.

IncrNeg: Initiates an incremental move in the negative direction upon the 
Start Motion Input.

JogPos: Initiates a jog move in the positive direction when the Start Motion 
Input is active. When the Start Motion Input is not-active motion is stopped.

JogNeg: Initiates a jog move in the negative direction when the Start Motion 
input is active. When the Start Motion input is not-active motion is stopped.

Home: Initiates the homing sequence that is defined in the Home Setup 
tab. The position, velocity, accel/decel and force settings in that row will be 
disabled (not used) for this move type.

No Action: Allows user to configure an unused move in the table in order to 
prevent unintended motion. If this move is executed, the ACS Drive will do 
nothing. The position, velocity, accel/decel and force settings in that row will 
be disabled (not used) for this move type.

ACS Servo Drive
Force: Allows user to configure a push to force move upon start motion 
input. (see Force Move Settle Time, 12.1.1)

NOTE: See Start Motion Input (see Appendix 1: Timing Diagrams)
Position Move position value for either absolute or incremental moves.  This field is not 

used in JogPos or JogNeg move types.

Velocity Velocity value for all move types
Accel/Decel Acceleration and Deceleration value for all move types
Force % Force % value from 10 to 100% for all move types.

Table 14-1: Descriptions of Setup Table Move Definitions for 4, 8, and 16 Move 
Commands 
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 Commands. If the ACS Drive has not been previously configured or it has been res

Figure 14-1: Mode Setup– 4 Move Commands, Not Configured

Figure 14-2: Mode Setup– 8 Move Commands, Not Configured
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Figure 14-3: Mode Setup– 16 Move Commands, Not Configured

 NOTE: Default Move Command velocities, acceleration, and deceleration are 0. 
If user does not configure a valid value for all motion parameters the TMI software 
and the ACS Drive will not allow that move to be executed.

For the move types of Home and No Action the fields for Position, Velocity, Accel, 
Decel and Force do not apply. They appear grey and are disabled for these move 
types. 

With Home move type the parameters used in the homing routine are from the 
Home Setup tab. Using a Home move type in the Index Move table allows the user 
to free up an additional digital input. 

The No Action move type is used to prevent unwanted moves from being 
commanded. If this type is configured, the controller will simply do nothing when it 
is commanded to move to that move number.

Figure 14-4: Mode Setup– The Home & No Action commands disable several fields.

 NOTE: The 

software controlled 

MS# LEDs will light 

to indicate what 

digital input pattern 

corresponds to that 

row. Similarly, you 

can use the mouse to 

click and toggle the 

MS# LEDs On/Off and 

the row corresponding 

to that binary code will 

be selected.
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14.1.2 Editing, Arranging and Testing Move Commands
Once all the Move Commands have been configured, there are several features 
in the Mode Setup screen for editing, arranging, or testing the configured Move 
Commands.

Move Row  Up / Down:  Move the Move Commands up and down one 
row at a time in the table.  

 

Copy / Paste / Cut  Row:  Copy, Paste & Cut functionality for each row.  
Select the row and click button for desired functionality.  

Teach:  Teach all motion profile parameters (position, velocity, accel/
decel, force) from the Motion Manager (see Section 15: Motion 
Manager Tool) into the selected row in the table. If the selected row 
already has valid data, the TMI will prompt the user whether they want 

to overwrite it or not. If the ACS Drive is disabled (See Motion Manager) pressing 
teach will only update the position (not Velocity/Accel/Decel or Force). This is useful 
for manually positioning the actuator then teaching that position.

Execute Move:  Clicking this button will execute or start the selected 
move in the table.  The selected move is denoted by the move 
highlighted in blue with the black arrow on the left hand side.  For Jog 
moves, the move is initiated while the Execute Move button is pressed 
and will stop when the Execute Move button is released.  

Motion Manager:  Opens and closes the Motion Manager tool (see 
Section 15: Motion Manager Tool)

    

Write Flash:  Write Current Settings to Drive Flash:  Write all 
parameters from the TMI software into the drive flash memory.
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Software Controlled:  When the TMI is in Software Control, all motion commands 
(Start Motion and Home inputs) from the I/O interface (PLC or logic controller) are 
ignored. In order to test the I/O logic with the PLC or logic controller, the user must 
select Digital Input Controlled. 

While in Software Control, the user can test the moves by using the Software 
Controlled Move Test Sequence. This feature allows up to 16 Move Commands to 
be tested in any order. When in Software Controlled mode, the Move Select (MS#) 
LEDs in the Digital Input Controlled group box will echo the logic of the selected 
Move Command in the table. The Software Controlled mode feature has the 
following controls: 

Figure 14-5: Software Controlled User Options

Add:  Click Add to add a Move Command to the next available position.

  

Reset:  Removes all Move Commands from the test sequence

Play:  Initiates the test sequence.  All Move Commands in sequence will be 
executed once.

Stop:  Stops the test sequence.

Pause:  Pauses the test sequence on the highlighted move.

Step:  Steps through the test sequence one Move Command at a time.

Cycle Continuously: When this feature is checked, the  test sequence cycles 
continuously in an endless loop until the Stop or Pause button is clicked, the user 
switches to the Digital Input Controller, navigates to another tab, or communication 
is disconnected.

When the test sequence is in progress:

1.	 All other move controls in Mode Setup and Motion Manager will be disabled.

2.	 The currently executed move will be highlighted in blue in the table.  

Move Delay: User settable dwell between test sequence moves. (Not Pictured) 

 NOTE: Jog and 

No Action moves as 

well as empty boxes 

will be skipped when 

playing the sequence.
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Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select 
Digital Input Controlled. When in this mode, all move buttons in the software are 
disabled and motion can only be initiated from the logic controller (PLC).  The 
selected move from the Move Select inputs (see Section 10: I/O Tab) will be 
highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital 
Input Controlled group box will echo the logic of the Move Select inputs from the 
physical I/O interface. In this mode, the PLC or logic controller can select the 
desired move using the Move Select inputs and initiate motion using the Start 
Motion input (see Appendix 1: Timing Diagrams). 

 

Figure 14-6: Digital Input Controlled

 NOTE: When Software Controlled is selected the MS1 to MS4 “LEDs” will track 
the selected line in the Move Definitions table.

Figure 14-7: Configured Mode Setup, 16 Move Command Mode



ACS Servo Drive

 Tolomatic User Guide:           Motion Control Interface
 •  14_7  •

DISCONTINUED Product Style, 
Size or Part no. This guide is for 
reference only. See 3604-4184 

for current ACS Tolomatic Motion 
Interface (TMI) Guide

14 :   T H E  M O D E  S E T U P  T A BMode Setup

14.1.3 FORCE Move Type
The FORCE move type is similar to the ABSOLUTE position move but with additional 
logic added to help with press at force applications. For safety of the user and 
equipment, the FORCE move is run as a position move in the way that it uses the 
position, velocity, and current control loops as opposed to other servo drives that 
only use the current loop for a force move. The advantage to using all three loops 
is to have control over the actuator speed; speed is not controllable with current 
loop only implementations. The current loop has a limiter at the input to limit the 
maximum current to the value of the move FORCE % as setup in each move’s 
profile. A position command past the point of press may be desired to reach this 
desired force.

Important notes about the Force move behavior:

   •	The Force Move Settle Time is a timer that starts counting when the Force % 
has been reached, and ends when the Force Move Settle Time in milliseconds 
has passed. This timeout will set the motion complete output to ON and another 
move may be commanded. If the Force % has not been reached then the Force 
Move Settle Time starts when the move trajectory completes. 

   •	It is recommended that the next move after a FORCE move that releases the 
press also be a Force move with the same Force %. This will ensure smooth 
force transitions and prevent unwanted jumps or spikes in force as well as 
prevent position error fault from triggering. 

   •	Position error Fault is disabled during Force moves.

   •	  WARNING: If a press move has reached its Force % and the load 
is suddenly removed, the actuator may accelerate quickly toward the 
commanded position at an un-regulated speed. This is due to the large 
position error and the proportional integral gains trying to compensate for the 
error. 

The following examples shows a force move where an actuator presses into a 
spring fixture until a force is achieved. The only difference between the two scope 
captures is the Force Move Settle Time.

Figure 14-8: Entries for Force Move



ACS Servo Drive
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Figure 14-9: Force Move Settle Time set to 100 msec 

Figure 14-10: Resulting Motion Profile, 100 msec Settle Time

 1.	 Force move begins (Press move)

 2.	 Actuator begins compressing a spring

 3.	 Actuator reaches Force % value, Force Move Settle Time timer begins

 4.	 Force Move Settle Time

 5.	 Motion Complete signaled

 6.	 Start new Force move (Release move) to back off of the spring.

 7.	 Move complete, motion complete will be signaled after Force Move Settle Time. 



ACS Servo Drive
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Figure 14-11: Force Move Settle Time set to 1000 msec 

Figure 14-12: Resulting Motion Profile, 1000 msec Settle Time

 1.	 Force move begins (Press move)

 2.	 Actuator begins compressing a spring

 3.	 Actuator reaches Force % value, Force Move Settle Time timer begins

 4.	 Force Move Settle Time

 5.	 Motion Complete signaled

 6.	 Start New Force move (Release move) to back off of the spring. 

 7.	 Move complete, motion complete will be signaled after Force Move Settle Time. 
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ACS Stepper Drive

ACS Servo Drive

14.2 Pneumatic Mode
Pneumatic mode is used to replace or mimic pneumatic cylinder/valve operation 
logic.  With pneumatic mode, there are four different selections:  Spring, 2 Position 
(2 input), 3 Position (2 input) & 3 Position (3 input).  These four pneumatic mode 
operations allow just about any pneumatic valve logic to be replaced with the 
ACS drive.  Additionally, in pneumatic mode, the drive will automatically home the 
actuator upon power up based on the home setup configuration.  

 NOTE: The default configuration for Pneumatic Mode automatically enables 
drive upon power up. Because of this, the only way to clear a fault is to cycle power 
unless the enable input is configured to a digital input in the I/O tab.

The setup table used for pneumatic mode has the following columns:

Setup Table Move Definitions
Label Descriptive alpha-numeric “name” for each Move Command.  Limited to 28 

characters, all uppercase.

Move Type Absolute: Initiates an absolute move upon change of Move Select bits. 
(STEPPER DRIVE: Pneumatic Mode only supports Absolute Moves)

Absolute: Initiates an absolute move upon change of Move Select bits. 
(SERVO DRIVE: Pneumatic Mode supports Absolute and Force Moves)

Position Move position value for absolute moves.  This field is not used in JogPos or 
JogNeg move types.

Velocity Velocity value for all move types

Accel/Decel Acceleration and Deceleration value for all move types

Force % Force % value from 10 to 100% for all move types.

Table 14-2: Descriptions of Setup Table Move Definitions for Pneumatic Mode 

 NOTE: Default Move Command velocities, acceleration, and deceleration are 0. 
If user does not configure a valid value for all motion parameters the TMI software 
and the ACS Drive will not allow that move to be executed.

Figure 14-13: Pneumatic, Spring
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Figure 14-14: 2 Position (2 input)

Figure 14-15: 3 Position (2 input)

Figure 14-16: 3 Position (3 input)
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Digital Input Controlled:

In order to test the I/O logic with the PLC or logic controller, the user must select 
Digital Input Controlled. When in this mode, all move buttons in the software are 
disabled and motion can only be initiated from the logic controller (PLC).  The 
selected move from the Move Select inputs (see Section 10: I/O Tab) will be 
highlighted in blue in the table below. The Move Select (MS#) LEDs in the Digital 
Input Controlled group box will echo the logic of the Move Select inputs from the 
physical I/O interface. In this mode, the PLC or logic controller can select the 
desired move using the Move Select inputs and initiate motion using the Start 
Motion input (see Appendix 1: Timing Diagrams). 

 

Figure 14-17: Digital Input Controlled

 NOTE: When Software Controlled is selected the MS1 to MS3 “LEDs” will track 
the selected line in the Move Definitions table.
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14.3 Analog Position Mode
14.3.1 Configuring Analog Position Mode

Analog Position mode is used to equate an analog input voltage or current to 
position.  The ACS Drive will convert the analog input to a scaled position range.  If 
the ACS Drive has an analog output installed, the position of the encoder will be 
scaled to the analog output.  If the ACS Drive has not been previously configured for 
Analog Position mode or has been restored to factory defaults, the Analog Position 
mode will be configured with zero Min/Max Position, Velocity, Accel/Decel to prevent 
any motion.  The Min/Max Position, Velocity, Accel/Decel fields will be highlighted in 
light red indicating they are invalid settings (see Figure 14-18 below).

Figure 14-18: Default Analog Position Mode for Voltage

The mode setup for Analog Position mode has the following parameters that must 
be configured for proper operation.

Min/Max Voltage or Current:  The range of Voltage is 0 to 10VDC and the range 
of Current is 0 to 20mA.  

Min/Max Position:  The configured positions that are equated to the Min/Max 
Voltage or Current setting.  The ACS Drive will then linear interpolate the Analog 
Input and equate it to position based on the Min/Max Voltage or Current settings 
along with the Min/Max Position settings.  

Velocity:  Velocity value for any Analog Position move
VOLTAGE/CURRENT

PO
SI

TI
ON

(Vmin, Pmin)

(Vmax, Pmax)
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Accel/Decel:  Acceleration and deceleration value for any Analog Position move

Force:  Force % value from 10 to 100% for any Analog Position move

Deadband:  Plus / Minus window for Analog Input that is ignored or not used to 
create motion.

Position Update Rate:  This setting adjusts the rate at which position commands 
are updated based on the changing Analog Input.  A slower setting means the 
response of the system will not be as dynamic.  A faster setting means the system 
will respond more quickly

Figure 14-19: Settings for Analog Position mode for Voltage

Relationship between Analog Mode & Start Motion Input:  

1. If Start Motion Input is configured in I/O Tab then user must set the Start 
Motion input ON to get motion. If Start Motion is configured and is set to OFF, 
user will not get motion after adjusting analog input.

2. In I/O Tab unmapping Start Motion input relieves the responsibility of setting 
Start Motion input to get motion using Analog input.

 NOTE:  If the Analog Output option is not installed, the Output slider will not be 
visible.  

 NOTE:  If the motor doesn't have an encoder, the analog output will be forced 
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to 0 (volts or mA) and not used. 

 

 NOTE:  In Analog mode Motion Select functions should not be mapped to digital 
inputs because they have no effect on the motion.  

In the example above:

	 0 volts = 0 inch position

	 10 volts = 4 inch position

All moves will move with 3 inch/sec velocity, 10 inch/sec2 accel/decel and 100% 
force.

14.3.2 Simulating the Analog Input
To simulate the analog input and test the logic setup for Analog Position mode, click 
on the Simulate Analog Input check-box. This will disable all the Analog Position 
Setup variables and the calibrate Analog I/O button because changes are not 
allowed when attempting motion.  There are two sliders in the Test Analog Position 
box:  one for an Input and one for the output.  The Input is enabled and the user 
can change the values of the simulated analog input to create motion.  The output 
slider should mimic the value of the analog output based on the actual position, if 
the motor has an encoder.

Figure 14-20: Simulating Analog Input

 NOTE: When Simulate Analog Input is not checked, the output slider may be moved 

to manually change the analog output of the ACS drive. 
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14.3.3 Analog Input Controlled
Analog Input Controlled is used to test the logic of the Analog Position mode setup 
with actual external hardware such as a PLC.  When the Analog Input Controlled 
button is pressed, the message below will be displayed.  

WARNING:  If “Yes” is selected, the user should expect motion as the ACS Drive will 
attempt to move in accordance with the Analog Position Setup.  

Figure 14-21: Confirm motion warning window

Once in this mode, the PLC or external Analog source can be used to test the 
system.  

Figure 14-22: Analog Input Controlled

14.3.4 Calibrating Analog Input & Output
For advanced applications where positional accuracy is extremely important, the 
Analog I/O Calibration tool can be used to calibrate both the Analog Input and 
Output.  Press the Calibrate Analog I/O tool from the Mode Setup screen to launch 
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the tool. Once in Analog I/O Calibration, the user can not navigate to any other 
screens in the Tolomatic Motion Interface (TMI).  The user must click the Calibrate 
Analog I/O check box to enable the calibration process. 

For analog input calibration, a voltage / current source and a meter (ohm / multi 
meter) will be required.  Input a voltage or current to the ACS Drive and measure 
with the meter.  Enter that value into the Measured Input field and press the 
associated Calibrate Min or Max button.  For voltage, the recommended ranges are 
1-4 volts for the Min voltage and 6-10 volts for the Max voltage.  For current, the 
recommended ranges are 2-8 mA for the Min current and 12-20 mA for the Max 
current.  

The analog input also has a software filter that is adjustable to give flexibility to the 
user on how dynamic the Analog Position control should be.  With a filter setting 
more towards Min, the analog filter will do less filtering and the analog input signal 
will give the controller more raw data in which to respond.  With a filter setting more 
towards Max, the analog filter will do more filtering causing the analog input signal 
to the controller to be smoother (less noisy).  

For analog output calibration, a meter (ohm / multi meter) will be required.   Enter a 
Min voltage or current  (1 - 4 volts or 2 - 8mA) into the Test Output field press Test 
Min and then measure with the meter.  Enter the measured value into the Measured 
Output field and press Calibrate Min button.  Repeat procedure for Max voltage or 
current (6 - 10 volts or 12 - 20mA) and press the Calibrate Max button. 

Figure 14-23: Sample of completed Analog I/O calibration
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14.4 Network Mode (Modbus RTU, EtherNet/IP & Modbus RTU)
14.4.1 Using Network Mode

Once the ACS Drive has been configured for the desired Actuator and Motor, 
Network mode can be configured for control with Modbus RTU, EtherNet/IP or 
Modbus TCP protocol.  Depending on the model ordered, the TMI software will only 
show either Modbus RTU, EtherNet/IP or Modbus TCP (also known as Modbus TCP/
IP, Modbus/TCP or Modbus-TCP). In this section Network refers to Modbus RTU, 
EtherNet/IP or Modbus TCP protocols

When Mode Select is configured for Network operation, the Mode Setup tab will allow 
setup of up to 16 moves.  The Network Move GroupBox displays the most recently 
commanded move.  Please note that the Current Position is displayed instead of the 
Position from the move table or the position sent over the network.  The reason for 
this is to be able to track the absolute position at all times.  Move number 0 indicates 
a move commanded by the TMI Motion Manager or the Network connection. 

When the TMI user presses the Network Controlled radio button, or whenever the 
Modbus RTU (or EtherNet/IP Modbus TCP or Modbus RTU) client commands a move 
the Host in control indicator (as seen on the Drive Status Tool) will turn off and the 
TMI controls will be disabled.  This keeps the TMI user from changing parameter 
values while the Modbus RTU, EtherNet/IP or Modbus TCP client is commanding 
movement.

Figure 14-24: Modbus RTU Controlled 

or

Figure 14-25: EtherNet/IP Controlled

or

Figure 14-26: Modbus TCP Controlled

When Network is in control, the controls in the Mode Setup tab’s Network Move 
GroupBox show the most recent move commanded by the Modbus RTU, EtherNet/
IP or Modbus TCP client.  Note that rather than displaying the commanded position, 
the Current Position is displayed.

 NOTE: The 

TMI software will 

determine if EtherNet/

IP, Modbus TCPBus 

RTU is appropriated 

based on the ACS unit 

connected.

 NOTE: To setup 

ACS drive for Network 

communication, the 

Ethernet port must be 

configured using the 

Ethernet Setup Tool. 

See Section 21 for 

details.
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To return control to the TMI host, either press the Software Controlled radio button, 
or select one of the tabs other than Mode Setup.

Figure 14-27: Software in control, last commanded move is highlighted.

The Host in control indicator on the Drive Status tool indicates whether TMI (the 
Host in this case) is in control.

ACS Stepper Drive

ACS Servo Drive

Figure 14-28: Drive Status tool indicates Software (Host) is in control.
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Figure 14-29 EtherNet/IP (or Modbus TCP, Modbus RTU) in control, last commanded move 
is highlighted.

ACS Stepper Drive

ACS Servo Drive

Figure 14-30: Drive Status tool indicates EtherNet/IP (or Modbus TCP, Modbus RTU) is in 
control.
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Relationship between Network Mode (Modbus RTU, EtherNet/IP or 
Modbus TCP) & I/O:  

When user selects Network Mode all digital inputs and digital outputs are set to 
"Not Configured". This way PLC or HMI can map any desired condition to them 
and set/reset digital output accordingly. When not configured, digital inputs don't 
have any effect. If user selects Network Mode and maps functions to digital 
outputs and digital inputs, they behave as follows: 

Enable Digital Input is set to ON and Network command disables the ACS Drive, 
the ACS Drive remains enabled.

Enable Digital Input is set to OFF and Network command enables the ACS Drive, 
the ACS Drive becomes enabled

If Software-Stop Input is wired to digital input, configured in TMI and Software-
Stop input is ON, the ACS Drive will not move even if motion is commanded over 
Network.

 NOTE:  In Network Mode motion select functions should not be mapped to 
digital inputs because they have no effect on the motion.
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Motion Manager Tool15
15.1 Using the Motion Manager

The Motion Manager allows the user to enable/disable the motor, home, and create 
simple motion commands (Absolute, Incremental, Jog). The Motion Manager is a 
can also be used for positioning in order to teach Moves into the Mode Setup table 
(see Section 14: Mode Setup Tab).

Figure 15-1: Launching the Motion Manager Tool

15.1.1 Controls
Enable/Disable: Enables or Disables drive and output to motor.

Home: Initiates Home sequence configured in Home Setup Tab.

Enabled, Homed, Motion Complete LEDs: Status LEDs.

15.1.2 Motion Profile
Position: Displays actual position from encoder or commanded position without 
encoder. Motion profile (Velocity, Accel, Decel, Force) per Jog, Absolute and 
Incremental moves in Motion Manager.

15.1.3 Jog
Jog Neg: Initiates a Jog Move with motion profile settings in a negative direction.

Jog Pos: Initiates a Jog Move with motion profile settings in a positive direction.

 NOTE: Jog move will be initiated while Jog Neg or Jog Pos button is held down 
by mouse click. The jog move will stop when the mouse click is released.
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Figure 15-2: Motion Manager Panel

15.1.4 Absolute Move
Initiates an absolute move to entered position parameter with motion profile 
settings.

15.1.5 Incremental Move
Incr Neg: Initiates an incremental move the size of the entered distance parameter 
in a negative direction.

Incr Pos: Initiates an incremental move the size of the entered distance parameter 
in a positive direction.
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Tuning Filter Tool16
Tuning a servo motor is an advanced procedure.  Tolomatic standard motors have 
predetermined tuning values that should work for most applications. Tuning should 
be performed when more performance is required for the application or when a new 
motor is added. A basic understanding of PI (Proportional Integral) Control Loops is 
required for tuning.

The Servo Control Loop for Position Control is made up of three separate PI loops: 
Position, Velocity, and Current loops. These three control loops are cascaded, 
meaning that the output of one loop feeds into the input of the next loop. The 
position loop uses profile position from the trajectory generator and actual position 
from the feedback device to commanded velocity.  The velocity loop uses the sum 
of commanded velocity from the position loop and profile velocity and compares 
it to actual velocity to generate a commanded current.  This commanded current, 
along with the actual current, is used to control the PWM to the bridge circuit which 
in turns drives the servo motor.  

Figure 16-1: Control Loop

Each control loop corresponds to a set of tunable parameters in the Tuning Filter.
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16.1 Tuning Filter Dialog
The Tuning Filter tool is broken into two distinct parts – the Parameter Adjustment 
pane, and the Graphing Pane.  The parameters are adjusted in the left hand side of   
the window, and the effects can be observed on the right hand side of the window.

  

Figure 16-2: Tuning Filter Dialog

16.1.1 Parameter Adjustment Pane
   •	Bus Voltage: Bus voltage of the system, typically 24V or 48V. Note: This setting 

affects the calculation of current loop gains.

   •	Reflected Inertia Match: Inertia match of the system.  Note: This setting affects 
the calculation of velocity loop gains.

   •	Proportional Bandwidth: Proportional bandwidth value for the given PI loop 
(Position, Velocity, Current) used to calculate proportional gain. The value can 
be changed using the numeric up/down box or by clicking on the graph.

   •	Integral Bandwidth: Integral bandwidth value for the given PI loop(Position, 
Velocity, Current) used to calculate integral gain. The value can be changed 
using the numeric up/down box or by clicking on the graph.

   •	Feed Forward: Percentage value that helps match commanded output to profile 
output. Typically used to smooth at the cost of precision
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   •	Err Sum Max: Percentage value that can be used to limit the amount of error 
calculated in the loop. Useful in limiting runaways and over corrections.

   •	Save to Flash: Saves the tuning settings of the specific loop to internal storage 
on the drive so that it can be maintained when the system power cycles

   •	Test Move: Configures the drive for a continuous sequenced position move 
between two points using the user defined settings.  Current tuning inputs 
a square wave of specified force amplitude into the current loop instead of 
performing a position move.  NOTE: Tuning uses relative positioning.  Make 
sure that you are aware of your actuators position with relation to its stroke 
length before performing any moves to prevent a crash. 

   •	Home Here: Declares home position value of 0.0 at the current position

   •	Restore Initial Values: Restores to the drive the initial tuning values saved when 
the tool was opened.  Note that is not a restore to factory defaults.  In order to 
do this, you should run the File->Restore Drive to Factory Settings command 
from the TMI menu

For the majority of setups, the user will only need to adjust the Bus Voltage and 
the Reflected Inertia Match slider. It is recommended that users do not modify the 
Current PI loop tuning parameters if using Tolomatic standard motors.  

Advanced Option - Adjusting the Tuning Range Min/Max: If more range is desired, 
each bandwidth’s combo box min/max can be adjusted by right clicking on that 
parameter’s combo box, and selecting “Adjust Min/Max”.

 

16.1.2 Graphing Pane
The graphing pane can display variables recorded during motion so the effects 
of changing tuning parameters can be seen.  The drive supports a limited sized 
internal buffer for onboard sampling. The data is transferred after a move has 
completed.

   •	Graphing Profiles: Selectable outputs that can be graphed for analysis

   •	Sample Rate: Rate in Hertz at which parameters are sampled

   •	Sample Length: The total length of the sampling period, in seconds

   •	Control Loop Diagrams: Helpful diagrams that display the input and outputs of 
each PI loop
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Figure 16-3: Position PID Loop

Figure 16-4: Velocity PID Loop
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Figure 16-5: Current PID Loop

16.2 Gain Adjustments and Effects
The following section describes generally what each gain adjustment does with 
relation to motion using the Tuning Filter dialog.

16.2.1 Position Proportional

Figure 16-6 – Good Position Proportional Gain

A good position proportional gain setting should follow the position profile closely 
without much overshoot. This gain affects how quickly the control loop can follow a 
fast change in commanded position. 



ACS Servo Drive

 Tolomatic User Guide:           Motion Control Interface
 •  16_6  •

DISCONTINUED Product Style, 
Size or Part no. This guide is for 
reference only. See 3604-4184 

for current ACS Tolomatic Motion 
Interface (TMI) Guide

16 :   T U N I N G  F I L T E R

Figure 16-7: Position Proportional Gain - Too High: Oscillations

Figure 16-7: Generally the higher the proportional gain the faster the control loop 
can follow a fast change in the position command. A Position proportional gain too 
high can create oscillations and rough motion. 

Figure 16-8: Position Proportional Gain - Too Low: Large Position Error

Figure 16-8: Position proportional gain too low can be sluggish and fall behind the 
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desired motion profile. Falling behind creates position error that can accumulate 
during the move and then take a while to wind down causing an overshoot of the 
desired position. 

16.2.2 Position Integral

Figure 16-9: Good Position Integral Gain

Figure 16-9: A good position integral gain setting should follow the position profile 
closely without much overshoot and it should settle to a steady state position equal 
to the commanded position. 
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Figure 16-10: Position Integral Gain – Too Low: Slow steady-state response

Figure 16-10: A position integral gain set too low can increase position error during 
motion and slow the steady-state response of seeking the final position value. 

Figure 16-11: Position Integral Gain - Too High: Overshoot which gets corrected over time

Figure 16-11: A high position integral setting can accumulate error during the move 
and cause too much overshoot of the final position. Some overshoot oscillation can 
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occur also. 

16.2.3 Velocity Proportional

Figure 16-12: Good Velocity Proportional Gain

Figure 16-12: A good velocity proportional gain should create quick loop response 
to a fast change in velocity. Proportional gain will affect mainly the rising and falling 
slopes of the velocity profile. 

Figure 16-13: Velocity Proportional Gain - Too High: Large Oscillations in Velocity

Figure 16-13: Setting velocity proportional gain too high can result in large 
oscillations in velocity during a move.
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Figure 16-14: Velocity Proportional Gain - Too Low: Slow Velocity Response

Figure 16-14: Setting a velocity proportional gain too low can result in sluggish 
response to changes in velocity. It may not even reach the commanded velocity 
value.

16.2.4 Velocity Integral

Figure 16-15: Good Velocity Integral Gain

Figure 16-15: A good velocity integral setting will help reduce the error in the 
constant velocity section of the velocity profile. 
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Figure 16-16: Velocity Integral Gain - Too High: Oscillations

Figure 16-16: Setting the velocity integral gain too high can cause oscillations 
in the constant velocity section of the velocity profile. It can increase the velocity 
overshoot.

Figure 16-17: Velocity Integral Gain - Too Low: Steady-state velocity error 

Figure 16-17: Too low of velocity integral gain will result in the loop not tracking to 
desired velocity resulting in steady-state velocity error.
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16.2.5 Velocity Feed Forward

Figure 16-18: Default Velocity Feed Forward Gain (75%)

Figure 16-18: To increase performance and lessen the burden of control on the 
position loop, a velocity feed-forward (VFF) gain as an input to the velocity loop. 
Generally this value should not need to be adjusted much from the factory default 
setting.

Figure 16-19: Velocity Feed Forward Gain (0%) - Higher Position error, higher velocity 
error

Figure 16-19: Decreasing the VFF gain or setting it to zero will cause the control 
response to be very sluggish. A higher position loop gain may be needed to get 
acceptable motion. The maximum velocity achievable may be reduced based on the 
position loop gains. Position and velocity error will increase.
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Figure 16-20: Modified Velocity Feed Forward Gain (100%) Low position and velocity 
error, causes overshoot

Figure 16-20: Too much VFF gain will cause velocity overshoot and possibly 
position overshoot.

16.2.6 Current Proportional

Figure 16-21 - Good Current Proportional Gain

Figure 16-21: A good current proportional gain setting will have a fast response to 
changes in current command.
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Figure 16-22: Current Proportional - Too High: Visible Oscillations

Figure 16-22: Setting the current proportional gain too high will cause high 
overshoot and oscillations in response to fast changes in current command.

Figure 16-23: Current Proportional - Too Low: Sluggish Response

Figure 16-23: Setting current proportional gain too low will cause sluggish response 
to changes in current command. 

16.2.7 Current Integral

Figure 16-24: Good Current Integral
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Figure 16-24: Good current integral gain should reduce steady state current error.

Figure 16-25: Bad Current Integral - Too High: Large Overshoot and oscillations

Figure 16-25: Too much current integral gain will cause large overshoot spikes in 
current and oscillations to occur

Figure 16-26: Bad Current Integral - Too Low: Actual not reaching commanded

Figure 16-26: Too little current integral gain will have large steady state current 
error.

16.2.8 Current Tuning
The user should not need to touch the current tuning gains for Tolomatic motors.  
However, if the need should arise, the following method can be used to tune the 
current loop.

Step 1: Set Integral Gain to 0, and set proportional gain to about 300
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Step 2: Set Step force to 30% and start the Test Move

This will inject a 100 Hz commanded current square wave directly into the current 
loop to see how the control loop response to an ideal step input signal. The gains 
should be adjusted to make the actual current fit closely to the commanded current 
with little overshoot and steady-state error. 

Figure 16-27: Current Loop Starting Point

Step 3: Increase Proportional Bandwidth until visible oscillations appear.  

About 3-4 oscillation periods should be visible after the edge of the step input 
signal. 

Figure 16-28: Current Loop Tuning - Proportional Bandwidth Oscillations

Step 4: Set Proportional Bandwidth to 40% of the oscillation bandwidth.

In our example, we saw oscillations at a bandwidth of 1931.18.  1931.18 x .40 = 
772.472

Step 5: Increase Integral Bandwidth slowly until desired response is 
reached.  

This starting point is as follows, with integral set at .01:
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Figure 16-29: Current Loop Tuning - Integral Bandwidth @ .01

As you increase, the level of the signal will rise. Try to keep the overshoot under 
10%.

Figure 16-30: Current Loop Tuning - Integral Bandwidth @ 180
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The Digital I/O tool is launched from the Tools Menu in the TMI interface menu bar 
or the Tool Bar. This tool shows the current status of the physical I/O interface. The 
description of each input and output is dependent on the I/O configuration from the 
I/O Tab (see Section 10: I/O Tab)

Figure 17-1: Launching the Digital I/O Tool

Figure 17-2: Digital I/O Tool

Digital I/O Tool17
17.1 Using the Digital I/O Tool
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The Analog I/O tool is launched from the Tools Menu in the TMI interface menu 
bar or the Tool Bar. This tool shows the current status of the physical Analog I/O 
interface. The units will be Volts or mAmps as determined by the Analog Position 
Settings (see Mode Select tab Section 9.1)

Figure 18-1: Launching the Analog I/O Tool

Figure 18-2: Analog I/O Tool

18.1 Using the Analog I/O Tool

Analog I/O Tool18
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The Software Oscilloscope uses the serial communications interface to continuously 
poll user selected parameters.  This tool is useful for live system debugging where a 
lower update rate is acceptable (~15-25ms).  

19.1.1 Select Channels
   •	Channel 1-4: User selectable parameters (up to four) to display

   •	Channel Settings: Channel specific configuration items

19.1.2 Triggering
   •	Auto Trigger: Continuously polls the drive and automatically updates the graph 

as data arrives.  Performs the same function as Auto Update + Start Listening

   •	Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

Software Oscilloscope19
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19.1.3 Parameter Trigger (Offline Sampling Only)
   •	Trigger Channel: The user selected channel to use as a trigger input

   •	Trigger Condition: A conditional statement to be used in conjunction with Trigger 
Channel and Trigger Condition Value.  For instance if the Trigger Condition is 
“LESSTHAN”, sampling would occur when Trigger Channel is less than the 
Condition Value.  

   •	Trigger Active: Activate the triggering condition

19.1.4 Sampling Controls
   •	Start Listening: Start polling the drive for the selected channels.  Used in 

conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   •	Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   •	Auto Update: When listening, the trigger condition will be constantly true, 
forcing the queue to be updated and graphed continuously

Cursor Information displays data to the user when the user clicks on two different 
places in a graph.  This will display X and Y values as well as distance and time 
between the two mouse clicks.

19.2 Channel Definition Window
Accessible from the Channel Settings button

   •	Output Channel: Selected parameter for the channel

   •	Chart Area: Assignable to a specified chart area (0-3).  It is possible to have 
multiple channels graphing to the same chart area
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   •	Color: User definable channel color

   •	Y Axis Assignment: Useful for graphing multiple parameters that require 
different scaling

	    o	Primary: Left Y Axis

	    o	Secondary: Right Y Axis

19.3 Menu Strip
19.3.1 File

   •	Export Graphs

	    •	As CSV: Exports the data displayed in a CSV format

	    •	As Image: Saves the graph as an image

   •	Advanced Tools

	    •	Get Time From Drive: Uses drive time instead of arrival time for  
	 sample timestamps

 	   •	 Time Index at Zero: Uses a zero based relative time index for graphing  
	 of the data instead of actual time

19.3.2 Profiles

   •	Default: All available configured signals

   •	Current: Only Current related signals

   •	Velocity\Position: Only Velocity and Position signals

   •	Network Diagnostics: Special network specific signals
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   •	Load From File: Load saved signals from a file

   •	Save Profile As…: Saves the currently loaded signal profile to disk

19.3.3 Sampling Controls

   •	Start Listening: Start polling the drive for the selected channels.  Used in 
conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   •	Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   •	Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

   •	Sampling Parameters: Launch Sampling Parameters options window

   •	Toggle Advanced Controls: Hides/Shows the Controls frame at the bottom of the 
graph (enabling a larger graphing area)

19.3.4 Sampling Parameters Options Window

   •	Sample Buffer Size: Sample Size of the circular sampling buffer for each 
channel

   •	PreSample Buffer Size: Number of samples to save before a trigger occurs.  In 
auto trigger mode, this is automatically set to 0



 Tolomatic User Guide:           Motion Control Interface
 •  19_5  •

DISCONTINUED Product Style, 
Size or Part no. This guide is for 
reference only. See 3604-4184 

for current ACS Tolomatic Motion 
Interface (TMI) Guide

19 :   S O F T W A R E  O S C I L L O S C O P E

   •	Sample Rate: Best effort sampling poll rate from TMI to the drive.  The sample 
rate may be slower based on transfer rates, number of channels being 
sampled, etc

   •	Apply Sample Rate: Applies the changes made to the Sampling Parameters

   •	Use On Board Sampling: Some drives provide on board sampling for higher 
sample rates. When available, this option will allow on board sampling and off 
board viewing. This option is only available if TMI is in control of motion. 

19.4 Context Menu Strip (Right click on graph)
19.4.1 Zoom Out: Zooms out of the graph

19.4.2 Sampling Controls

   •	Start Listening: : Start polling the drive for the selected channels.  Used in 
conjunction with Triggering.  When a trigger is detected, the sampling queue 
fills and is displayed when the queue is filled

   •	Stop Listening: Stops the drive polling and prevents the currently displayed data 
from being overwritten

   •	Manual Trigger: When Listening, Manual Trigger triggers the start of a sample, 
and will display the data after the sampling has completed

19.4.3 Copy to Clipboard

   •	Image: Copies the graph as an image to the clipboard so it can be pasted into 
external applications
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   •	CSV: Copies the data as CSV text into the clipboard so it can be pasted into 
external applications

 

19.4.4 Export As…

   •	Image: Saves the graph as an image

   •	CSV: Exports the data displayed in a CSV format

 

19.4.5 Change Sample Series Type

   •	Default (Line): Straight Line connecting sample to sample
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   •	Step Line: Step function between samples (Digital)

   	

   •	Spline: Smoothing transitions between samples

   	

   •	Column: Each sample is represented by a column
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   •	Point: Each sample is represented by a point

   	

 

19.4.6 Graph

   •	Reset Axis Scales: Forces the redrawing and auto-scaling of the axis scales for 
all of the graphs
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20.1 Using the Drive Status Tool
The Drive Status Tool is launched from the Tools Menu in the TMI interface menu 
bar or the Tool Bar. This tool shows the current status of critical information about 
the drive.

Figure 20-1: Launching the Drive Status Tool

ACS Stepper Drive

ACS Servo Drive

Figure 20-2: Drive Status Tool

Drive Status Tool20
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Ethernet Setup Tool21
21.1 Using the Ethernet Setup Tool

Choose the Tools -> Ethernet menu selection or press the Configure Ethernet button 
in the toolstrip.

 
Figure 21-1: Launching the Ethernet Setup Tool

Figure 21-2: Ethernet setup tool

Enter the IP address, Subnet Mask and Default Gateway parameters for the 
network.  (The values shown above are the factory default values for the ACS drive.  
Typically, at least the IP address and Default Gateway will need to be changed for 
the network.) Settings are downloaded when OK is pressed.
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Feature Description Troubleshooting Tips
Obtain an 
IP Address 
automatically

Enables DHCP support on the 
drive, allowing a server to 
assign an IP address to the 
drive 

IP Address IP Address of the drive The ACS Drive supports Ping. Pinging 
the drive is a great way to verify that the 
drive is on the network.

Subnet Mask Subnet Mask of the drive
Default Gateway Default Gateway of the drive
Enable UDP 
Socket Support

Enables TMI to connect to 
drive over the network using 
port 7023 (ACS Servo Only)

Firewalls may automatically block 
Port 7023.  Check with your network 
administrator if you are not able to 
connect over this port, but are able to 
ping the drive.

MAC Address MAC Address of the drive
Link Status Current connection status of 

the drive (Up / Down)
If the Link Status reports Down, Ethernet 
communications will not function. Check 
physical connections, and verify lights 
on Ethernet ports are on.

Duplex Mode Communications Duplex Mode 
(Full / Half)

For the Network Controlled modes (EIP 
and Modbus TCP), the drive is required 
to be in Full Duplex mode. If the drive is 
reporting Half duplex, errors are dropped 
connections are expected.

Speed Communications Speed of the 
connection (10 Mbps or 100 
Mbps)

OK Applies the settings and exits 
the tool

Test Initiates a Ping connection test 
to the drive

The PC and the drive must be configured 
and connected to the same network.

Default Resets the Ethernet settings to 
the factory defaults

Cancel Exits the configuration tool

Table 21-1: Ethernet connection troubleshooting tips

The test button can be used to initiate a ping test to the drive. The PC and the drive 
must be connected to the same network.

NOTE:  An Ethernet cable must be connected from the PC to the ACS drive.

If the Test worked, a screen will pop-up showing similar results to the following.

Figure 21-4: Testing verifies a successful Ethernet connection
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If the Test didn’t work (in this example, the Ethernet cable was unplugged from the 
ACS drive) an error dialog will be shown.

Figure 21-5: Testing indicates a failed attempt for Ethernet connection

A "Yes" response will open the Ping Test window that will continually ping the 
address and give you a visual online/comment state.

Figure 21-7: Ping Test failure and success

To configure the ACS drive for DHCP server in order to dynamically assign an IP 
Address:

   •	check the “Obtain an IP address automatically” check-box

   •	click OK on the ACS Internet Protocol (TCP/IP) Properties dialog

   •	click the Disconnect button on the TMI Drive tab (or press the Disconnect from 
Drive button on the toolstrip)

   •	click Yes when asked “Update drive flash memory?”.

   •	cycle ACS drive power (turn off then turn on)

   •	press the Connect button on the TMI Drive tab (or press the Connect to Drive 
button on the toolstrip)

When the Ethernet configuration tool is opened, the status bar informs the status of 
the DHCP address configuration process.  This is not dynamically updated.  To see 
the current status, press Cancel (or OK), wait a bit, then open this tool again.
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Figure 21-6: Obtaining an IP address automatically

If there is a problem and the ACS drive is unable to get an IP address from the 
DHCP server, the status bar will display the error message in the status bar.

When Ethernet configuration is complete, press OK.
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Ethernet Advanced Diagnostics22

22.1 Using Ethernet Advanced Diagnostics

When connected to Ethernet enabled ACS drives TMI will display Ethernet MIB 
Counters in Tools > Advanced Diagnostics Menu.

Figure 22-1: Advanced Diagnostics pull-down

Management Information Base (MIB) Counters
The ACS Drive provides 30 MIB counters per port. These counters are used to 
monitor the port activity for network management. Counters are polled every 10 
seconds while the dialog box in Figure 22-2 is visible. When closed, polling stops. 
Pink highlighted text box indicates a problem reading the counter (this should rarely 
occur). Bold numbers indicate a change since previous poll. Use the box in the 
lower left corner to choose either Port 1 or Port 2: this corresponds to ACS Ethernet 
Port 1 and Port 2.

Figure 22-2: Ethernet MIB Counters
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TMI LABEL DESCRIPTION

TxOctets Tx lo-priority good octet count including PAUSE packets

Tx Dropped Packets TX packets dropped due to lack of resources

TxBroadcastPackets Tx good broadcast packets (not including error broadcast or valid multicast 
packets)

TxMulticastPackets Tx good multicast packets (not including error multicast or valid broadcast 
packets)

TxUnicastPackets Tx good unicast packets

TxCollisions Tx total collision, half duplex only

TxSingleCollisions Successfully Tx frames on a port for which Tx is inhibited by exactly one collision

TxMultipleCollisions Successfully Tx frames on a port for which Tx is inhibited by more than one 
collision

TxDeferred Tx packets by a port for which the 1st Tx attempt is delayed due to the busy 
medium

TxLateCollisions The number of times a collision is detected later than 512 bit-times into the Tx 
of a packet

TxExcessive A count of frames for which Tx fails due to excessive collisions

TxPausePackets Number of PAUSE frames transmitted by a port

RxOctets Rx lo-priority (default) octet count including bad packets

Rx Dropped Packets RX packets dropped due to lack of resources

RxBroadcastPackets Rx good broadcast packets (not including error broadcast packets or valid 
multicast packets)

RxMulticastPackets Rx good multicast packets (not including MAC control frames, error multicast 
packets or valid broadcast packets)

RxUnicastPackets Rx good unicast packets

RxUndersizePackets Rx undersize packets with good CRC

RxOversizePackets Rx oversize packets with good CRC (max: 1536 or 1522 bytes)

RxJabbers Rx packets longer than 1522 bytes with either CRC errors, alignment errors or 
symbol errors (depends on max packet size setting)

RxAlignmentErrors Rx packets within (64, 1522) bytes with a non-integral number of bytes and a 
bad CRC (upper limit depends on max packet size setting)

RxCRCErrors Rx packets within (64, 1522) bytes with an integral number of bytes and a bad 
CRC (upper limit depends on max packet size setting)

RxPausePackets
Number of PAUSE frames received by a port.  Pause frame is qualified with 
EtherType (88-0xh), DA, control opcode (00-01), data length (64B min), and a 
valid CRC

RxSymbolErrors Rx packets with invalid data symbol and legal packet size.

64Packets Total Rx packets (bad packets included) that were 64 octets in length

65to127Packets Total Rx packets (bad packets included) that were between 65 and 127 octets 
in length

128to255Packets Total Rx packets (bad packets included) that were between 128 and 255 octets 
in length

256to511Packets Total Rx packets (bad packets included) that were between 256 and 511 octets 
in length

512to1023Packets Total Rx packets (bad packets included) that were between 512 and 1023 octets 
in length
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TMI LABEL DESCRIPTION

1024to1522Packets Total Rx packets (bad packets included) that were between 1024 and 1522 
octets in length (upper limit depends on max packet size setting)

Table 22-1: ACS Ethernet Drive MIB counters

Advanced Network Counters

Figure 22-3: Menu selection of Advanced Network Counters

The ACS Drive provides extremely low level access to the network counters 
used by the network stack implemented in firmware.  The Advanced Network 
Counters tool is an expert level tool designed specifically for deployment engineers 
troubleshooting network related issues.  While the MIB Counters provide access to 
registers on the Ethernet Hardware directly, the Network Counters are maintained 
by the ACS Firmware.  

Launching the tool from the Tools->Advanced Diagnostics->Advanced Network 
Counters will bring up the tool's interface.

Figure 22-4: Advanced Network Counters Interface

The user can select an appropriate refresh rate based on the number of 
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counters selected. If only a few counters are selected, 1-5 second intervals can 
be maintained. However, the flexibility of the tool allows for an extremely high 
number of counters to be selected.  Choose a slower refresh rate to increase the 
performance of the interface.  Once the refresh rate (in seconds) is selected, click 
the "Collect Counters" button.

The counters will be polled at the Refresh Rate interval.  As the values are collected, 
they will be displayed in a CSV format in the output window. 

Figure 22-5: Result of "Collect Counters" selection

The user can then save the CSV output to a file using the File->Save As... option

Figure 22-6: Save as .csv file for use in software like Excel
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The user can now import this file into a data analysis application (like Excel) and 
process the data.

Figure 22-7: Result of "Collect Counters" graphed in MicroSoft Excel
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Appendix 1: Index Move Mode - Move Select Logic

Index Move Mode - Move Select Logic Table

The three operating modes, 4/8/16 move commands, require digital inputs to select 
the desired move for execution. The digital inputs are called Move Select 1 through 
4 (MS1-MS4) in the digital input map. To select the desired move command refer to 
the three logic tables below.

NOTE 1: MS# stands for Move Select #

NOTE 2: 1 = On; 0 = Off

4 Move Commands Mode Logic Table
MOVE MS1 MS2

1 0 0
2 1 0
3 0 1
4 1 1

Table A1-1: 4 Move Commands Mode Logic

8 Move Commands Mode Logic Table
MOVE MS1 MS2 MS3

1 0 0 0
2 1 0 0
3 0 1 0
4 1 1 0
5 0 0 1
6 1 0 1
7 0 1 1
8 1 1 1

Table A1-2: 8 Move Commands Mode Logic
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16 Move Commands Mode Logic Table
MOVE MS1 MS2 MS3 MS4

1 0 0 0 0
2 1 0 0 0
3 0 1 0 0
4 1 1 0 0
5 0 0 1 0
6 1 0 1 0
7 0 1 1 0
8 1 1 1 0
9 0 0 0 1

10 1 0 0 1
11 0 1 0 1
12 1 1 0 1
13 0 0 1 1
14 1 0 1 1
15 0 1 1 1
16 1 1 1 1

Table A1-3: 16 Move Commands Mode Logic
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Pneumatic Mode - Move Select Logic Table

The pneumatic mode requires digital inputs to select the desired move for 
execution.  The digital inputs are called Move Select 1 through Move Select 3 
(MS1-MS3) in the digital input map.  To select the desired move refer to the four 
logic tables below.

NOTE 1: MS# stands for Move Select #

NOTE 2: 1 = On; 0 = Off

2 Position (1 input) Table
ACTION MS1

Pos 1 0
Pos 2 1

Table A2-1: 2 Position (1 input) Mode Logic

2 Position (2 input) Table
ACTION MS1 MS2

Stop 0 0
Pos 1 1 0
Pos 2 0 1

Current Pos 
Command 1 1

Table A2-2: 2 Position (2 input) Mode Logic

3 Position (2 input) Table
ACTION MS1 MS2

Stop 0 0
Pos 1 1 0
Pos 2 0 1
Pos 3 1 1

Table A2-3: 3 Position (2 input) Mode Logic
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Appendix 2: Pneumatic Mode - Move Select Logic

3 Position (3 input) Table
ACTION MS1 MS2 MS3

Stop 0 0 0
Pos 1 1 0 0
Pos 2 0 1 0
Pos 3 0 0 1

Current Pos 
Command 1 1 1

Current Pos 
Command 1 1 0

Current Pos 
Command 0 1 1

Current Pos 
Command 1 0 1

Table A2-4: 3 Position (3 input) Mode Logic

 NOTE: If logic selects Current Pos Command, then the controller will continue to 

current commanded position. If already in position, no motion will occur. 
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Appendix 3: Tolomatic Firmware Upgrade Tool

Tolomatic Firmware Upgrade Tool

 SAFETY WARNING: Disconnect the drive from Ethernet, RS485, actuator, 
motor, encoder & brake before upgrading firmware. You should only have power 
and communications line (serial or USB) connected. Only use Tolomatic authorized 
firmware to upgrade your ACS drive. Running unauthorized firmware on the ACS 
drive will result in unexpected behavior.

 WARNING: Do not disconnect the drive during the firmware upgrade upload. 
Doing so may damage the drive. 

 NOTE: Because upgrading firmware will reset your drive to factory default state it is 

recommended that you backup your current ACS drive settings before upgrade. 

A3.2.1 Installation Instructions
A3.2.1.1 Installing from the Tolomatic CD

1. 	 Insert the software CD supplied by Tolomatic into the CD-ROM drive in your PC.

2.	 Follow the link on the displayed web page to install the latest software and view 
the manuals (requires internet connection)

3.	 If internet connection is not available, browse the CD and double-click the "Tol
omaticMotionInterface[version].exe" file to run the installer. 

4. 	 Follow the prompts to install the software. The installer automatically installs 
the Tolomatic Firmware Upgrade Tool  and appropriate ACS Drive .hex files.

The software will install a program launch icon in the Windows® Start menu at:

Start > All Programs > Tolomatic > TolomaticMotionInterface[version] 
> TolomaticFirmwareUpgradeTool

In the Start menu the program will start with single click.
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Appendix 3: Tolomatic Firmware Upgrade Tool

A3.2.1.2 Downloading and Installing from the Tolomatic Web  
Site at www.tolomatic.com

The Tolomatic Motion Interface can be downloaded from the Tolomatic web site at 
www.tolomatic.com/resources/index.cfm?catalog_id=1, click on the software tab.

1. To download, click on "Resources" in the navigation bar at top. Select "Electric 
Linear Motion" picture or text under the "Select a Product Line...:" subhead. 
When on the "Electric Linear Motion" page the default tab is "Catalogs & 
Brochures" select the tab “Software” third from the left.  

2. Select the "Current Tolomatic Motion Interface v. _ _ _" from the listing 
(it should be the first listing) and save the file when prompted to your hard drive.

3. Double-click the "TolomaticMotionInterface.exe" file to run the installer.

4. Follow the prompts to install the software. The installer automatically installs the 
Tolomatic Firmware Upgrade Tool  and appropriate ACS Drive .hex files.

The software will install a program launch icon in the Windows® Start menu at:

Start > All Programs > Tolomatic > TolomaticMotionInterface[version] 
> TolomaticFirmwareUpgradeTool

In the Start menu the program will start

A3.3.1 Saving Current Drive Settings
After successful firmware upgrade, the Tolomatic Firmware Upgrade Tool will 
restore the drive to factory settings appropriate to the new version of firmware, 
overwriting any user defined settings.

Figure A3-1: Using the Save As backup current ACS drive settings before upgrading 
firmware

If you run the Tolomatic Motion Interface, connect to the drive and select the  
File->Save As menu item, you can save the current drive settings to a file.  The 
next time you run Tolomatic Motion Interface after upgrading the drive firmware, you 
can select File->Open and open this file.  The parameter settings in the file will 
automatically be programmed into the Tolomatic drive.

 NOTE: This step is most 

useful if you want to BACKUP 

current ACS Drive settings 

before upgrading firmware. 

(Upgrading will force the ACS 

Drive to factory defaults) After 

upgrading firmware open 

TMI software and restore 

ACS Drive settings using the 

procedure outlined at right.

www.tolomatic.com/resources/index.cfm?catalog_id=1
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Appendix 3: Tolomatic Firmware Upgrade Tool

A3.4.1 Launching the Upgrade Tool Software
1. Double-click the program icon on the desktop or in the Windows® Start menu at: 
Start > All Programs > Tolomatic > TolomaticMotionInterface[version] 
> TolomaticFirmwareUpgradeTool to launch the software.

Figure A3-2: Select the correct version of the Firmware Upgrade Tool

 NOTE: If user experiences a permissions error, try running TFUT as Administrator.

A3.5.1 User Interface Process 
  •	 As in TMI, setting COM Port to Auto will request TFUT to scan available ports 

looking for an ACS drive and automatically select that COM port.  If the ACS 
drive does not have valid ACS firmware, the COM port must be selected 
manually.

  •	 Status and progress messages are displayed in the read-only text box.

  •	 Flash baud rates of 19200, 38400, 57600, 115200 (default) and 230400 are 
supported.

•	 A Show ACS Drive Info button is provided to query the Product Name, Model, 
Firmware Version, and Drive Name.  This is useful in conjunction with COM 
Port: Auto.  [Note that the ACS firmware always communicates at 38400 
baud – the firmware flash speed is configurable] Auto should be used for USB 
updates for Servo.

ACS Servo Drive

ACS Stepper Drive

 NOTE: Stepper 

Firmware uses .hex 

extension.

 NOTE: Servo 

Firmware uses .tol 

extension.
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Appendix 3: Tolomatic Firmware Upgrade Tool

Figure A3-3 Connected to ACS Drive

•	 A Reset Drive button allows the ACS drive to be reset.

•	 If no Hex File is specified, pressing Program will run a connection test (useful 
for troubleshooting only)

•	 A progress bar shows how the firmware flashing process is progressing

Figure A3-4: Firmware Flashing Progress
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Figure A3-5: Firmware Flashing Complete

A3.6.1 TFUT Integrated with TMI
In addition to being available as a stand-alone tool, the Tolomatic Firmware Upgrade 
Tool (TFUT) is now available from TMI.  Selecting this menu item will cause TMI to 
disconnect from the ACS drive (discarding any changes) and open a modal TFUT 
dialog.

Figure A3-6: Upgrade Firmware through TMI
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